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Preface

Thank you for purchasing this Topcon product. The materials available in this Manual (the “Manual”) have been prepared by
Topcon Positioning Systems, Inc. ("TPS") for owners of Topcon products, and are designed to assist owners with the use of
the receiver and its use is subject to these terms and conditions (the “Terms and Conditions”).

@ Please read the terms and conditions carefully.

Terms and Conditions

Preface

Use

This product is designed to be used by a professional. The user should have a good knowledge of the safe use of the product
and implement the types of safety procedures recommended by the local government protection agency for both private use
and commercial job sites.

Copyrights

All information contained in this Manual is the intellectual property of, and copyrighted material of TPS. All rights are reserved.
Do not use, access, copy, store, display, create derivative works of, sell, modify, publish, distribute, or allow any third party
access to, any graphics, content, information or data in this Manual without TPS' express written consent and may only use
such information for the care and operation of the receiver. The information and data in this Manual are a valuable asset of
TPS and are developed by the expenditure of considerable work, time and money, and are the result of original selection,
coordination and arrangement by TPS.

Trademarks

HIPER®, TILT™, Topcon® and Topcon Positioning Systems™ are trademarks or registered trademarks of TPS.
Windows® is a registered trademark of Microsoft Corporation. The Bluetooth® word mark and logos are owned
by Bluetooth SIG, Inc. and any use of such marks by Topcon Positioning Systems, Inc. is used under license. Other
product and company names mentioned herein may be trademarks of their respective owners.

Disclaimer of Warranty

EXCEPT FOR ANY WARRANTIES IN AN APPENDIX OR A WARRANTY CARD ACCOMPANYING THE PRODUCT, THIS MANUAL
AND THE RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT BE
LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL OR THE
RECEIVER. SUCH DISCLAIMED DAMAGES INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS OR DESTRUCTION OF
DATA, LOSS OF PROFIT, SAVINGS OR REVENUE, OR LOSS OF THE PRODUCT'S USE. IN ADDITION TPS IS NOT RESPONSIBLE
OR LIABLE FOR DAMAGES OR COSTS INCURRED IN CONNECTION WITH OBTAINING SUBSTITUTE PRODUCTS OR
SOFTWARE, CLAIMS BY OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY EVENT, TPS SHALL HAVE NO LIABILITY
FOR DAMAGES OR OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY IN EXCESS OF THE PURCHASE PRICE FOR THE
RECEIVER.

P/N: 1010117-01 vi



Preface

License Agreement

Use of any computer programs or software supplied by TPS or downloaded from a TPS website (the “Software”) in
connection with the receiver constitutes acceptance of these Terms and Conditions in this Manual and an agreement to abide
by these Terms and Conditions. The user is granted a personal, non-exclusive, non-transferable license to use such Software
under the terms stated herein and in any case only with a single receiver or single computer. You may not assign or transfer
the Software or this license without the express written consent of TPS. This license is effective until terminated. You may
terminate the license at any time by destroying the Software and Manual. TPS may terminate the license if you fail to comply
with any of the Terms or Conditions. You agree to destroy the Software and manual upon termination of the use of the
receiver. All ownership, copyright and other intellectual property rights in and to the Software belong to TPS. If these license
terms are not acceptable, return any unused software and manual.

Confidentiality

This Manual, its contents and the Software (collectively, the “Confidential Information”) are the confidential and proprietary
information of TPS. You agree to treat TPS’ Confidential Information with a degree of care no less stringent that the degree
of care you would use in safeguarding your own most valuable trade secrets. Nothing in this paragraph shall restrict you
from disclosing Confidential Information to your employees as may be necessary or appropriate to operate or care for the
receiver. Such employees must also keep the Confidentiality Information confidential. In the event you become legally
compelled to disclose any of the Confidential Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

Website; Other Statements

No statement contained at the TPS website (or any other website) or in any other advertisements or TPS literature or made
by an employee or independent contractor of TPS modifies these Terms and Conditions (including the Software license,
warranty and limitation of liability).

Safety

Improper use of the receiver can lead to injury to persons or property and/or malfunction of the product. The receiver should
only be repaired by authorized TPS warranty service centers.

Miscellaneous

Miscellaneous

The above Terms and Conditions may be amended, modified, superseded, or canceled, at any time by TPS. The above Terms
and Conditions will be governed by, and construed in accordance with, the laws of the State of California, without reference
to conflict of laws.

P/N: 1010117-01
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Manual Conventions

This manual uses the following conventions:

Convention Description Example
Bold Menu, or drop-down menu selection File » Exit (Click the File menu and click
Exit)
Name of a dialog box or screen From the Connection screen...
Button or key commands Click Finish.
Mono User supplied text or variable Type guest, and click Enter.
Ttalic Reference to another manual or help document | Refer to the 7opcon Reference Manual.

@@S
@
\ 4

Preface

Further information to note about system configuration, maintenance, or setup.

Supplementary information that can have an adverse affect on system operation, system
performance, data integrity, measurements, or personal safety.

Notification that an action has the potential to result in system damage, loss of data, loss of
warranty, or personal injury.

P/N: 1010117-01
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Introduction

Topcon'’s HiPer HR receiver is a compact and high-performing integrated GNSS receiver for static and kinematic
land surveying applications. The receiver design includes 452 GNSS channel Vanguard Technology™ with
Universal Tracking Channels, and advanced integrated Fence Antenna™ technology. These technologies deliver
world class positioning and navigation capability to your application by tracking signals with multiple frequencies
and multi-constellation satellite systems such as GPS, GLONASS, BeiDou, QZSS, SBAS and Galileo.

To create a future proof, efficient positioning system appropriate for any survey needs, the receiver combines
GNSS tracking capabilities, multiple-frequency RTK, and DGPS solutions, extensive communication capabilities,
built-in 8 GB memory, integrated batteries, and hot swappable batteries.

Several unique features, including advanced multipath mitigation, adjustable Phase Locked Loop (PLL) and Delay
Locked Loop (DLL), offer a reliable and versatile reception of weak signals even in degraded signal environments.
The receiver also supports Quartz Locked Look™ (QLL) for superior GNSS tracking in high-vibration environments.

The HiPer HR offers complete IP67 protection against dust and water ingress, in addition to superior vibration and
shock resistance. The Topcon communication interface allows you to quickly integrate Topcon’s premium GNSS
performance within new systems, and quickly deliver world class positioning and navigation support to your
applications.

Figure 1: HiPer HR Receiver

Introduction P/N: 1010117-01 1



HiPer HR Features

The HiPer HR receiver’s advanced design allows a simplified setup and premium performance. The HiPer HR
receiver features the following:

® 452 GNSS channel Vanguard Technology™ with Universal Tracking Channels for multi-frequency tracking
of multiple satellite constellations such as GPS, GLONASS, BeiDou, QZSS, SBAS and Galileo.
* Industry leading full-wave Fence Antenna™ technology
* An internal battery and a removable external battery
* An internal UHF or FH915 radio modem
* Integrated Bluetooth®, multi-channel LongLink™, and Wi-Fi wireless and radio technology!
* Wi-Fi as an access point and as a client
* Web interface for receiver monitoring and configuration
¢ Interface for controlling and viewing data logging through the LED display
* Topcon Integrated Leveling Technology (TILT™)
¢ External power, USB, and serial-data ports
* External GNSS antenna connector
¢ Internal 8 GB SDHC memory card
* Virtual serial port via USB
* Mass storage data access via USB
The HiPer HR comes in one of the following configurations:

¢ R2 Lite UHF radio module

* R2 Lite FH915 radio module
* No UHF/FH915 radio

=]
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Unpacking Your Receiver Kit

This section describes the documentation, standard kit components?, and accessories (depending on your
purchase) that accompany your receiver. When you unpack your receiver kit, verify that you received the items
listed in this section. If any items are missing or damaged, contact your local Topcon dealer. See “Getting
Technical Support” on page 4.

Standard Kit Components

Table 1 lists the standard kit components for the HiPer HR. For more information about the included cables, see
“Cables” on page 7.

Table 1. HiPer HR Standard Kit Components

HiPer HR Receiver Power Cable

Power Adapter Wall Charger Cable

Micro USB Cable Serial Cable

Additional Removable Battery Pack Battery Charger with Cradle
Battery Charger Cable Warranty Card

LED Card — Describes the LED behavior and

technical content.

1. Bluetooth, LongLink, Cellular, and Wi-Fi wireless radio technologies are available in all configurations of the receiver. Local radio
restrictions apply for operation of these radio technologies.

2. Components in the standard kits may differ based on your region. Contact your local Topcon dealer to inquire about items included
in your regional standard kit, and accessories that are available with the receiver.

HiPer HR Features P/N: 1010117-01 2




Accessories

Topcon offers a wide variety of accessories specially designed to improve system flexibility and job site efficiency.
For more details on the optional accessories available for HiPer HR, contact your Topcon dealer.

Table 2 lists the accessories available for the HiPer HR. For more information about accessories, see
“Accessories” on page 8.

3
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Table 2. HiPer HR Accessories

Radio Antenna Rover Pole

External Antenna Cable Fixed Height Heavy Duty Tripod
Rover Pole Offset Adapters Economy Tripod

Tribrach with Plug Adapter Tape Measure

Horizontal Measuring Bar Prism

Hand-Held Controller and Brackets

Prism Adapter

Technical Documents

The following documents will help you set up and use your new receiver.

* HiPer HR Operator’s Manual (this document) — Contains detailed information on how to use your new receiver.
You can download the document from Topcon’s TotalCare website
(https://www.topconpositioning.com/support).

* HiPer HR LED Card - Contains basic hardware and LED descriptions, along with safety and regulatory
statements. This guide is available in your standard kit package.

* Topcon Receiver Utility (TRU) Help — An on-screen help document embedded in the software that contains
detailed information on how to use the TRU software. For more information about the TRU software, see
“Using Topcon Software With Your Receiver”.

Using Topcon Software With Your Receiver

Use the HiPer HR receiver in conjunction with the Topcon Receiver Utility (TRU) and MAGNET Field™ or Pocket-
3D applications for a precision positioning solution. Topcon software enables you to configure the receiver and
other external devices, manage files, collect data, and perform survey and construction work flows.

The Topcon Receiver Utility (TRU) is a hardware configuration software for receivers and peripheral devices. You
can install it on desktop computers, and data controllers. You can download this program from the myTopcon
website (https://www.topconpositioning.com/support). The help document for TRU is embedded in the
software.

Topcon’s MAGNET Field™ software for data controllers provides real-time communication, cloud storage, data
collection and exchange, and field solutions, such as topo, staking, roads, calculations, and more.

Pocket-3D is a field application for survey and construction markets. The software runs on data controllers with
Windows CE® and mobile platforms. Pocket-3D simplifies data collection, allowing you to check cuts and fills,
layout points and survey all or part of the job site quickly and efficiently.

Contact your Topcon dealer for more information about Topcon field data collection software for the surveying
and construction markets.

Technical Documents P/N: 1010117-01 3




Getting Technical Support

Before contacting a Topcon customer representative about any problems with the receiver, see
“Troubleshooting” on page 61 for some solutions that may fix the issue.

Contact your local Topcon dealer or visit the myTopcon website (https://www.topconpositioning.com/support)
for technical support.

@g For quick and effective support, provide a detailed description of the problem.

When contacting Topcon for technical assistance, provide the following information for better and faster service:

1. A description of the following:
— Field operation that was being performed when the problem occurred.

— Details of the unexpected behavior, symptoms, and any error messages that precede or follow the
problem.

— Problem occurrence frequency or patterns.
2. Receiver information and configuration settings. For receiver information, do the following:

a. Run TRU on a PC or a field controller, switch on the receiver.
Use serial or USB cable for connection.

Select Device » Application Mode » Receiver Managing.
Select Device » Connect.

Click Connect on the Connection Parameters screen to establish a communication to the
receiver.

f. In the TRU main screen, click Information. The Receiver Info screen appears, and displays
basic information such as hardware and firmware versions, RAM size, receiver ID, and serial

® oo o

number.
g. Click Save to File, enter a file name, and save it to the computer (Figure 2).
r B
=% Receiver Info Iﬂlﬂlﬂ
MName Value |
i Model HIPER._SR.
I O01LZUN20LE
@ Serial Number HiPer SR 1054-PP 10010
@ Board Version Bl 4 ] Save As [
S Firmware Version 4.0V Jun, 29,2012 b6 OO |). » Computer » Data (D) » OAF * Hiper HR -—| g | [ Seurch Hiper_HR ge)
i Hardware Version 205 =
i vendor Topcon I Plelpece: -
Save as lype: [ Text Fibes (*.txt) - |
38 CPU Freq., MHz 235
SERAM Size, KB 16,384 S swe | | cancel
E3Flash Memory Total, MB 3,839 i
EFlash Memory Available, MB 2,046
=IFlash Memory Free, MB 2,042
= TP - -
4] | Save to File
b

Figure 2: HiPer HR Receiver Info

3. Specifications of mobile devices and computers used in the field or office exhibiting the problem. These
specifications should include model information, version number, operating system information, memory
and storage capacity, etc.

4. Information about the system software, including the version number and steps to reproduce the problem.

5. A description of the field environment and/or observation conditions when the problem occurred.

Getting Technical Support P/N: 1010117-01
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Website

The Topcon Positioning System’s corporate website provides current information about Topcon’s line of
products. The support area of the website provides access to Topcon field and office software, manuals,
frequently asked questions, and so forth. To access the Topcon corporate website, visit
www.topconpositioning.com.

The myTopcon website provides complete support, such as news, updates, reminders, training, live webinars,
and customer service to help you get the information you need. Visit
https://www.topconpositioning.com/support.
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Getting Acquainted

The HiPer HR receiver enclosure is fully sealed and incorporates the GNSS receiver board, antenna, batteries,
memory storage, and a wireless communication modules in rugged housing.

Receiver Overview

The upper part of the receiver includes GNSS, Bluetooth and Cellular antennas. It is covered by the radome, and
securely surrounded by a shock-absorbing rubber bumper. The radio modem antenna connector is mounted on
the top point of the radome.

The magnesium alloy lower enclosure features an easy-to-operate display panel, one internal battery, one
removable battery, data ports, an external GNSS antenna connector, power connector and SIM card slot.

The receiver has a highly-visible display panel with single-button operation. The display panel enables you to view
the receiver’s operational status. For more information, see “Display Panel” on page 13.

You can locate regulatory and product identification information on the two receiver labels, which are located on
the bottom of the product and inside the battery compartment. The product identification label contains the serial
number and part number.

Getting Acquainted P/N: 1010117-01 6



Cables

The HiPer HR! package includes a power supply cable, a USB cable, and a power adapter. Table 3 describes the
cables included with your receiver, depending on your regional standard kit configuration. Make sure to contact
your local Topcon dealer to inquire about standard items included in your receiver kit.

~ Align the keyways when connecting the power/serial cable to the receiver port. To disconnect the
5 cable, push the cable in, and then gently remove the cable.
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Table 3. Receiver Cables

Cable Description Cable Illustration

Receiver Power/Charging Cable

Connects the receiver and the power supply unit via
SAE connectors for battery charging.

p/n 14-008016-04LF
Alligator Clips-to-SAE Cable

Connect the receiver power cable to an external 12V | &=} I i

battery.

Power Charger Cable(s)

Connects the power adapter to a grounded outlet.
Different options are available for the power charger
cable based on your country. To purchase this cable,
contact your Topcon dealer. Refer to this part
number

p/n 1005793-01 - Cable, Power Charger (US)

p/n 1005794-01 - Cable, Power Charger (EUR)

Micro USB Cable

Connects the receiver to an external device
(controller or computer) for data transfer and
receiver configuration.

p/n 1013602-01

Serial Cable

Connects the receiver to an external device
(controller or computer) for data transfer and
receiver configuration.

p/n 14-008005-03

External Antenna Cable (Optional) —

Connects the receiver to an external Topcon 7 \
GNSS antenna. |@_':-' V%
p/n 1006447-01 Z
_ =
-
@

1. Components in the standard kit may differ based on your region. Contact your local Topcon dealer to inquire about items included
in your regional standard kit, and accessories that are available with the receiver.

Cables P/N: 1010117-01 7




Table 3. Receiver Cables

Cable Description Cable Illustration

Alligator Clips Cable (Optional)

Connects any 12 - volt DC power source to the
receiver via the SAE cable.

p/n 14-008025-01

SAE-to- SAE extension cable (Optional)
Connects SAE connectors over longer distances.
p/n 14-008022-01

Accessories

Topcon offers a wide variety of accessories specially designed to improve system flexibility and job site efficiency.
For more details about the available accessories, contact your Topcon dealer.!

Power Supply Unit (p/n 1005555-01): This item charges the external (removable) and internal batteries
when connected to a grounded outlet. This unit converts the Alternating Current (AC), normally supplied from
an electrical outlet, to Direct Current (DC) for charging the batteries, and/or powering the receiver.

Battery Pack (p/n 1006555-01): External battery for the receiver.

Modem Antenna: The Spread Spectrum (FH915+) antenna is a reverse polarity TNC RF connection
(p/n 30-030012-01) and the UHF antenna is a BNC connection (p/n 30050501-01 UHF 435-470 or p/n
30050502-01 UHF 400-435).

Universal Tribrach and Tribrach Adapter? (p/n 22-006008-01 and p/n 22-006009-011): These items level
the tripod, and secure the receiver or antenna to the tripod.

Precision Tribrach Adapter: This item precisely centers, aligns, and levels the tripod over a point. The
horizontal spacer (p/n 51842) inserts into the precision tribrach, and allows the receiver to sit securely on the
precision tribrach.

Wooden Tripod (p/n 59010)
Heavy Duty Tripod (p/n 22-05050101)
2 Meter Fixed Height Rover Pole (p/n 22-050908-01)

Hand-held Controller: This items allows the HiPer HR Base and Rover systems to be configured and
monitored directly in the field. Use the Topcon Receiver Utility (TRU) to configure the receiver, and any Topcon
field data collection software.

MAGNET and Pocket-3D Software: These items can be used to operate the receiver. See the TRU Help
(embedded in the software) or the help files in the field collection software for more information.

HiPer HR External GNSS Antenna Cable (p/n 1006447-01): This item allows to connect to an external
GNSS antenna.

Battery Charger w/ Adapter (p/n 1010975-02): Dual charger for the external (removable) batteries.
Hybrid Positioning Adapter (p/n 1003241-01)

100 mm Prism Spacer (p/n 51949)

Tape Measure (p/n 22-050902-01) HV1034DM 3/4 x 12 ft. / 3.7 m PWR Tape 10ths.

1pps Cable (p/n 14-008066-01)

Accessories

. Some accessories may be included in the standard kit for your region. Contact your dealer for details.
. The universal tribrach and tribrach adapter are not needed when using the heavy duty tripod.

P/N: 1010117-01
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Batteries

The receiver has an internal battery and removable batteries, both rechargeable, for powering the receiver. For
more information about using the batteries, see “"Managing Power” on page 26.
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Figure 3: HiPer HR Removable Battery

Data and Power Ports

The HiPer HR has the following four ports (shown in Figure 4):
* Power - rimmed in red; used to connect the receiver to an external power source. This port can also be used
to charge the batteries. The body of the connector on the corresponding cable is red.
¢ Serial Port — rimmed in green; used for communication between the receiver and an external device.

¢ External GNSS Antenna — SMB connector rimmed in blue; used for connecting the receiver to an external
GNSS antenna for use in base station and rover station setups.

¢ USB - Micro USB connector; used for high-speed data transfer and communication between the receiver and
an external device.

1L

. External GNSS
Power  Serial
Antenna

(red) (green)
(blue) (&8 TOoPCON )

Micro USB

Figure 4: HiPer HR Ports
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External Radio Antenna Connector

The antenna of the FH915 or UHF radio modems plug into the external antenna connector on the radome
(Figure 5). The radio antenna uses a reverse polarity TNC or BNC connection depending on the installed radio
modem. The reverse polarity TNC connector is used for FH915, and the BNC connector is used for UHF.
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External Radio Antenna Connector
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Figure 5: HiPer HR Radome and External Antenna Connector

Internal Cellular Antenna

If using only the internal cell modem for your survey, do not insert the antenna into the external antenna
connector. In this case, the receiver will use only the internal cell modem antenna, mounted under the radome,
as shown in Figure 6.

Internal Cellular Antenna

LED Display Panel
Data and Power Ports

Figure 6: Internal Cell Modem Antenna
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SIM Card Location

The HiPer HR can use a Micro-SIM card. The SIM card is located under the door on the upper surface of the
removable battery slot (Figure 7). To install a SIM card, do the following:

1. Remove the external battery.
2. Remove the SIM card door using a TORX T6 screwdriver.
3. Insert the SIM card, and attach the external battery.

Once installed, the SIM card provides a unique identification for the receiver's GSM/CDMA module and enables
functionality based on the subscribed services. The receiver board accesses the GSM/CDMA module, which
accesses the SIM card. The SIM card can remain inside the receiver.

To configure the module, use MAGNET Field or TRU.
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SIM Card
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Figure 7: SIM Card Location
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Hardware Reset Button

Use the Hardware Reset button only when the unit will not power on from the Power button. Follow
the guidelines in “Troubleshooting” on page 61 before using the Hardware Reset button.

To perform a hardware reset, press the Reset button located under the removable battery compartment.
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Remove the external battery.

Remove the SIM card door using the TORX T6 screwdriver.
Press the Reset button using the screwdriver.

Close the SIM card door using the TORX T6 screwdriver.
Attach the external battery.

uikhwN=

Reset button

Figure 8: Reset Button Location

Hardware Reset Button P/N: 1010117-01




Display Panel

The receiver has a highly-visible display panel with single-button operation. The LED display panel (Figure 9)
allows for control of receiver power and data recording. The LEDs display the status of the satellite tracking,
recording/memory capacity, Wi-Fi and Bluetooth connections, cell modem status, and batteries. This chapter
describes the different LED blink patterns and what they mean.

Battery
REC Bluetooth Radio external

WaRa2a 3 aoiaalials .

Stat Wi-Fi Cellular Battery
internal

Figure 9: LED Display Panel

Power Button

The power button performs multiple functions. The duration in which the button is pressed and held determines
how the receiver will perform. While pressing the button, the LED panel indicates the selected operation using
particular LEDs. Table 4 describes how to use the power button.

Table 4. Power Button Functions and Descriptions

Function Press Button LED Description

Power On 1+ seconds Power LED blinks green until startup completes, then LED
is solid green.

Power Off 3-10 seconds Release the Power button when the STAT LED turns
yellow.

Start/Stop Data Three times in a row within 2 | Refer to the REC (Recording) LED description.

Logging seconds

Toggling between Static | Two times in a row within 1 Refer to the REC (Recording) LED description.

and Kinematic post- second This function is available for “Occupation mode switch”

processing modes only. See “Power Button Mode Switching” below.

Performing Factory 10-15 seconds Release the Power button when STAT LED blinks

Reset magenta. When the unit starts up, the REC LED

blinks yellow, and then operates normally.

A delay of several seconds occurs between the last clicking of the Power button and first blinking/last
blinking of the REC LED.

When using external power, the Power LED is solid green except for startup and shutdown procedures.

Display Panel P/N: 1010117-01 13



Power Button Mode Switching

The Power button operates in two modes: LED blink mode switch and Occupation mode switch. In Occupation
mode switch, you can switch the receiver between Static and Kinematic survey modes while recording a file.

You may select these modes in the Topcon Receiver Utility (TRU). To do so:
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1. Connect the receiver to a computer and open TRU.
2. Click Device » Application Mode » Receiver Managing.
3. Click Device » Connect. The Connection Parameters window appears (Figure 10).

%Mimhﬂ---_?l;lglil ‘f'.;.Sele::tht _?Iﬂ'l;lglil
Connect Using Friendly Name Physical Mame
[Seria| Part = ] =2 Communications Port (COM1) 1 \comM1

E:lPrnIiﬁu: |ISB-to-Serial Comm Port (COM3) Y\ \COM3

Port Name {2AProlific USB-to-Serial Comm Port (COM4) |1, \COM4

E:lPrnIiﬁu: |ISB-to-Serial Comm Port (COMSE) Y\ \COM5

E:lPrnIiﬁu: |ISB-to-Serial Comm Port (COMB) Y\ \COM&

Communications Port (COM1) @

Receiver Port

[] secondary Receiver

Serial &

Figure 10: TRU — Connection Parameters

4. Select the required connection method from the Connect Using drop down list. You can connect to the
HiPer HR using Serial Port, USB, Network, or Bluetooth.

5. If needed, select a port in the Port Name field. Click the (-] button. The Select Port window appears
(Figure 10).

6. Select the required port and click OK. The Connection Parameters window appears.

Click Connect to establish a connection with the receiver. The TRU main screen appears.

8. In the TRU main screen, click the File Explorer icon. The Logs tab appears (Figure 11).

N

= " P -

O~ === ol -[ax]
File Explorer Logs | AFRM | RINEX | FTP Push | Files |

Log | File M File Size B Cumrent Blevation Prefi MINTER & AFRM | AFRM Raotation Use for RINEX | =

g | e ame | P =28 Bl poging Period, s| Mask,® | | Logging Period,s |  Period,s | MINTER & AFRM | Version [—

A 15  Ida 1 3,600 Mo 3.00

B 12 lgb 9 3,600 Yes 2.10

C 5 logc 1 3,600 Mo MNone

n 7 Ind 7 2 AN Yoo Mnna

Figure 11: TRU — File Explorer Logs Tab

Power Button P/N: 1010117-01




9. Inthe Logs tab, right click any place to open the context menu and select Advanced MINTER Settings. O
The MINTER screen appears (Figure 12). n
F | v
- =
= MINTER 2o _ | Ol x| Q
= i PWR Key Mode <
Logs | AFRM | RINEX | FTP Push | Files | (@) LED blink mode switch g
Current Elevation (") Occupation mode switch 3
Log | File Name | File Size, B : ; 5 =
Logaing Period. s | Mask. Initial Data Collection Dynamic Mode Q
Edit ' (@) Static
B Kinematic
C Start File Logging (Default Settings)
D Start File Logging (Manual Settings) Data Recording Auto-start
E Stop File Logging (@) off
3 Advanced MINTER Settings e
G Default Message Set S () Always
H Site Parameters
1 Always Append to the File
] View »

Figure 12: Context Menu of Logs — MINTER

10. Select the required Power button mode in the FN Key Mode group box.

11. For the Occupation mode switch, select the default data collection method in the Initial Data Collection
Dynamic Mode group box.

12. Click OK. The File Explorer window appears.
13. Click OK.

You must click OK in both MINTER and File Explorer widows; otherwise, settings will not be
= applied.

14. Click Device » Disconnect.
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Receiver Status LEDs

There are eight status LEDs to provide information about satellite tracking, memory capacity, Wi-Fi, Bluetooth,
radio, and internal and external battery life. This section describes the color and behavior of each LED.

Status LED

Q

The tracking status LED displays the status of tracked satellites when the receiver is on.

[oued Ae|dsig

Table 5. Status LED Descriptions

Display LED Color Description
Green Blink One blink per tracked GPS satellite.
Yellow Blink One blink per tracked GLONASS satellite.
Cyan Blink One blink per tracked Galileo satellite.
Magenta Blink One blink per tracked BeiDou satellite.
Blue Blink One blink per tracked QZSS satellite.
White Blink One blink per tracked L-band Satellite.
Red Blink One blink per second when there are no tracked satellites or
solutions.
Two blinks per second when the receiver is in exception mode.
Otherwise, LED is dark.
Red-Green-Yellow OAF is expired.

Receiver Status LEDs P/N: 1010117-01




Recording LED

O

The recording LED indicates if data is being written to memory, and displays the current survey mode (static or
kinematic) when the Occupation mode switch is selected.
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Table 6. Recording LED Descriptions

Display LED Color Description

LED blink mode switch is selected

Green Blink File logging is in progress. Each blink indicates data is
being written to memory.

Red Solid File logging problem. No free memory, or hardware
problem with data recording.

LED is off when file is not logging data.

Occupation mode switch is selected

Green Blink File logging is in progress. The Static mode is the current
post-processing mode.

Yellow Bink File logging is in progress. The Kinematic mode is the
current post-processing mode.

Red Solid File logging problem. No free memory, or hardware
problem with data recording.

LED is off when file is not logging data.

o d 06
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Communication LEDs

The communication LEDs display the status of the wireless activity. The following tables describe the
communication activity for four use cases: Bluetooth, Wi-Fi and radio (UHF).

Bluetooth LED
oY
3

The Bluetooth LED displays the status of the Bluetooth activity. Table 7 describes the activity.

Table 7. Bluetooth LED Descriptions

Display LED Color Description
Blue Blink Bluetooth is on and waiting for a connection.
Blue Solid A single Bluetooth connection has been established.

Blue Solid + Blue Blink * N
every 10 seconds

Multiple (N) valid Bluetooth connections have been
established.

Communication LEDs

P/N: 1010117-01
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Cellular LED

The Cellular LED displays the status of the internal cellular modem. Table 8 describes the activity.

Table 8. Cellular LED Descriptions

Display LED Color Description
No Light The internal cell modem is switched off.
Green Solid Cell modem is on and waiting for a connection.
Green Blink The connection has been established.

Wi-Fi LED

S

A4

The Wi-Fi LED displays the status of Wi-Fi activity. Table 9 describes the activity.

Table 9. Wi-Fi LED Descriptions

Display LED Color Description
Green Solid The internal Wi-Fi modem is starting up.
Green Blink The internal Wi-Fi modem is transmitting or receiving data.

Communication LEDs

P/N: 1010117-01
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Radio LED

()

The Radio LED displays the status of the UHF or FH915+ modem. Table 10 describes the LED colors and
patterns for the UHF modem.
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Table 10. UHF Modem LED Descriptions

Display LED Color Description

Command mode (Rover and Base)

Red Blink - Green Blink - MAGNET Field or TRU sends commands to configure the
No Light modem.

Receiver mode (Rover)

Green Solid Modem is not receiving correction data.

Yellow Solid Modem is receiving correction data from a base.

@

Transmitter mode (Base)

Green Solid Modem is not transmitting correction data.

Red Solid Modem is transmitting correction data.

Retranslator mode (Base)

Yellow Blink - Red Blink Modem is receiving and transmitting correction data.

D )
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Table 11 describes the LED colors and patterns for the FH915+ modem.

Table 11. FH915+ Modem LED Descriptions

Display LED Color Description

Command mode (Rover and Base)

[oued Ae|dsig

Red Blink - Green Blink - | MAGNET Field or TRU sends commands to configure the

_\ ” No Light modem.
| 1
) )

DA

Receiver mode and Retranslator mode (Rover)

Green Blink Modem is not synchronized with a base.

Green Solid Modem is synchronized with a base and ready to receive
correction data.

Yellow Solid Modem receives correction data from a base.

Transmitter mode (Base)

Red Solid Modem transmits correction data.

Communication LEDs P/N: 1010117-01




Battery LEDs
Internal Battery LED

ra
U

The internal battery LED indicates the remaining charge of the internal battery. When using an external power
source, the LED turns solid green and begins to blink if the batteries are charging. See Table 12 for more
information.

[oued Ae|dsig

Table 12. Internal Battery LED Descriptions

Display LED Color Description

The receiver is on; the internal battery is in use

Green Solid The charge is greater than 50%.
Yellow Solid The charge is between 10% and 50%.
Red Solid The charge is less than 10%.

The receiver is on; external power source in use

Green Solid The internal battery is fully charged.

Green Blink The internal battery is at greater than 50% capacity; the
battery is charging.

Yellow Blink The internal battery is at greater than 10% capacity; the
battery is charging.

Red Blink The internal battery is at less than 10% capacity; the
battery is charging.
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Table 12. Internal Battery LED Descriptions

Display

LED Color

Description

The receiver is off

Green Solid

The receiver is connected to an external power source, and
the battery is fully charged.

Green Blink

charging.

The receiver is connected to an external power source, and
the battery is at greater than 50% capacity; the battery is

Yellow Blink

charging.

The receiver is connected to an external power source, and
the battery is at less than 50% capacity; the battery is

- - ® @

No Light

The receiver is not connected to an external power source.

Battery LEDs

P/N: 1010117-01
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External Battery LED

The external detachable battery LED indicates the remaining charge of the external battery. When using an

external power source, detach the battery from the receiver and connect it to the external battery charger. Once
connected to a charger, the LED turns green and begins to blink when the batteries are charging. See Table 13
for more information.

Table 13. External Battery LED Descriptions

Display

LED Color

Description

The receiver is on; the

external battery is in use

Green Solid The charge is greater than 50%.
Yellow Solid The charge is between 10% and 50%.
Red Solid The charge is less than 10%.

The receiver is on; the external battery is in use; external power in use

Green Solid An external power source is in use, and the external battery
charge is greater than 50%.
Yellow Solid An external power source is in use, and the external battery
charge is between 10% and 50%.
Red Solid An external power source is in use, and the external battery

charge is less than 10%.

The receiver is on; the external battery is disconnected from receiver

L
B
L
L
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L
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No Light

The receiver is using the internal battery only.

Battery LEDs

P/N: 1010117-01
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Table 13. External Battery LED Descriptions

Display

LED Color

Description

The receiver is off; the

external battery is in use

Green Solid The receiver is connected to an external power source, and
the battery is fully charged.

Green Blink The receiver is connected to an external power source, and
the battery is at greater than 50% capacity; the battery is
charging.

Yellow Blink The receiver is connected to an external power source, and

charging.

the battery is at less than 50% capacity; the battery is

Battery LEDs

P/N: 1010117-01
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Managing Power

This chapter describes how to power the receiver, charge the batteries, and use an external power source.
Turning the Receiver On/Off

To turn on the receiver, press and hold the power button until the LEDs briefly flash. The receiver is turning on
when: the Power LED blinks green, the receiver channels initialize and start tracking all visible satellites at any
time and location, and the serial port is available. When the startup is complete, the Power LED is solid green only
when external power is used; otherwise the Power LED is off. After startup, the integrated wireless devices in the
receiver are ready to use, and the receiver is available to start recording data to the internal memory.

To turn off the receiver, press and hold the power button for more than 3 (but less than 10) seconds. Release the
power button when the Power LED blinks yellow. This delay prevents the receiver from being turned off by
mistake. Allow the receiver to complete the power off cycle, which is approximately 30 seconds.

The receiver will draw a small amount of power from the external battery when it is turned off. If the
@@ receiver is placed in storage for a long period, 3-6 months, the battery may become fully discharged.
Use an external power supply or recharge the battery before use.

Powering the Receiver

The receiver is powered by an internal battery, a removable external battery, or an external valid power source
connected to the power port. If an external power source is connected, the receiver draws power from it instead
of the batteries. You can connect the receiver to an external power source, such as a vehicle battery, with 9 to 28
VDC to operate the receiver. See “Specifications” on page 66 for more information.

When the receiver is in use, the external battery will be discharged first, and then the internal battery. When a
valid external power supply is available, the receiver draws power from the external power supply.

See “Charging the Batteries” on page 28 for more information.

@ Power input greater than 28 VDC could damage the receiver.

Removable External Battery

The receiver first draws power from a connected external power source. When there is no valid external power
source connected, or if the source has discharged lower than 6.5V, the receiver will draw its power from the high-
capacity external removable battery.

The external battery is shipped from the factory with a partial discharge. For maximum operating time,

= fully charge the battery before using the receiver.
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Internal Battery

The receiver draws power from the internal (non-removable) battery once the external battery is discharged. If
there is no valid external power source connected, or if the source has discharged lower than 6.5V, or the
external battery is discharged, the receiver will draw power from the internal battery.

You can replace a discharged external battery with a charged one without interrupting receiver’s operation.

~ The internal battery is shipped from the factory with a partial discharge. For maximum operating
= time, fully charge the battery before using the receiver.

Operating Hours

Table 14 describes the use conditions and the operating hours of the receiver. The first values in the Approx.
Hour of Operation column are obtained while using both batteries (internal and removable external). The
second values are obtained while using the external removable battery only (internal battery is discharged).

Table 14. Operating Hours

Use Condition

Description

Approx. Hours of Operation?

Static Survey

Static setup logging raw GNSS data at
1 Hz.

5 hours / 2 hours 30 min

LongLink RTK Base

Base transmitting RTCM3 differential
corrections to one or multiple rovers at XX
output power.

5 hours / 2 hours 30 min

LongLink RTK Rover

Rover receiving RTCM3 differential
corrections over LongLink connected
through Bluetooth to a data collector.

5 hours / 2 hours 30 min

Network RTK Rover

Rover receiving RTCM3 differential
corrections from a Network correction
service, and connected through Bluetooth
to a data collector.

4 hours 30 min / 2 hours 15 min

UHF Receive Only Mode

Rover receiving RTCM3 differential
corrections over UHF radio connected
through Bluetooth to a data collector.

4 hours 15 min / 2 hours

UHF Transmitting at
05w

Base transmitting RTCM3 differential
corrections at 0.5 W.

3 hours 45 min / 2 hours

UHF Transmitting at
1w

Base transmitting RTCM3 differential
corrections at 1 W.

3 hours 30 min / 1 hours 45 min

UHF Repeater at 1 W

Receiving RTCM3 corrections, and
transmitting RTCM3 differential corrections
at 1 w.

3 hours 30 min / 1 hours 45 min

FH915+ Receive Only
Mode

Rover receiving RTCM3 differential
corrections over FH915+ radio connected
through Bluetooth to a data collector.

4 hours 30 min / 2 hours 15 min

FH915+ Transmitting at | Base transmitting RTCM3 differential 3 hours 15 min / 1 hours 30 min
0.25W corrections at 0.5 W.

FH915+ Transmitting at | Base transmitting RTCM3 differential 2 hours 30 min / 1 hours 15 min
1w corrections at 1 W.

FH915+ Repeater

Receiving RTCM3 corrections, and
transmit RTCM3 differential corrections at
1W.

2 hours 30 min / 1 hours 15 min

Internal Battery

P/N: 1010117-01
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Table 14. Operating Hours
UHF Receiver + Receiving RTCM3 corrections over UHF 4 hours 15 min / 2 hours
LongLink Base radio, and transmitting RTCM3 differential

corrections over LongLink.

FH915+ Receiver + Receiving RTCM3 corrections over FH915+ | 4 hours 30 min / 2 hours 15 min
LongLink Base radio, and transmitting RTCM3 differential
corrections over LongLink.

lanmod 3uiSeuepy

a. Average with Bluetooth on and 20 SVs tracked. Using new, fully-charged batteries, operating at room
temperature and transmitting at 1 Hz rate.

Charging the Batteries

While the battery loses charge, the BAT LED changes from solid green, to yellow and then red, depending on
the remaining charge (see "Battery LEDs” on page 22).

When the receiver is connected to an external power source, the internal battery is charging, regardless of the
receiver state. The external battery is charging only when the receiver is off. You can detach the external battery
and charge it with a separate battery charger.

To charge the internal battery:

1. Connect the supplied power cable to the receiver’s power port.
2. Connect the SAE connector of the power cable to the SAE connector of the power adapter.
3. Plug the power adapter into an available outlet for approximately five hours to fully charge the battery.

Overcharging the battery will not happen; the battery stops charging when it reaches full charge. During
charging, the BAT LED will blink (see Table 12 on page 22).

Use a grounded wall outlet, or grounded surge protector while charging. The socket should be
located near the equipment, and easily accessible.

Battery Charging Temperatures

Charge the batteries only in temperatures between 32°F (0°C) and 113°F (45°C).

An optimal charging temperature is between 50°F (10°C) and 77°F (25°C). If possible, charge
the batteries within this temperature range.

@ The charge terminates automatically if battery temperature rises above 113°F (45°C) or falls below
32°F (0°C).

Charging the Batteries P/N: 1010117-01



Attaching the External Battery

To attach the external battery:

1. With the battery slightly tipped, place the bottom of the battery into the bottom of the battery
compartment (Figure 13).

Figure 13: Attach HiPer HR Battery

2. Gently push the top of the battery into the battery compartment until it snaps into place, ensuring that the
clip at the top of the battery completely snaps into place.

Detaching the External Battery

To detach the external battery, use the clip at the top of the battery to gently pull down and out. The battery
will detach from the receiver (Figure 14).

ZZTOPCON

Figure 14: Detach HiPer HR Battery

Attaching the External Battery P/N: 1010117-01
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Surveying While Charging

The receiver can perform any kind of surveying while charging the internal battery without degrading
performance.

While charging, make sure the air temperature is between +32 °F (0 °C) and +113 °F (+45 °C). This
is important to prevent serious damage to the batteries and the receiver, or injury to persons.

Changing the Batteries While Surveying

It is safe to change a depleted removable external battery with a fully charged one while surveying (i.e., on the
fly) without turning off the receiver. Before doing this, make sure the internal battery has enough charge to
power the receiver while changing the depleted battery; surveying will not be disrupted.

Using an External Power Source

In addition to the removable battery, you can connect the receiver to an external power source (such as a
vehicle battery with 9 to 28 VDC) to operate the receiver, and for continuous use of the receiver if the removable
batteries become discharged.

@ Power input greater than 28 VDC could damage the receiver.

To connect the receiver to an external battery:

1. Combine the ODU-to-SAE cable (P/N 14-008016-04LF) and SAE-to-alligator clips cable (P/N 14-008025-01)
provided in your kit. This composite cable allows for charging the receiver Base station from an external
battery.

2. Connect the alligator clips to the external 12-V battery.
3. Insert the 5-pin ODU connector into the power port of the receiver.
4. Turn on the receiver.

Insufficient Power
If the batteries become fully discharged and an external power supply is not connected, the receiver will shut

down and automatically save recorded files. To avoid disruptions, check the BAT LED on the display panel for
the battery charge status. See “Battery LEDs” on page 22 for more information. If the receiver shuts down due

lanmod 3uiSeuepy

to insufficient power, the receiver and all communication ports become deactivated.
To restore power to the receiver do one or all of the following:

. 4
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* Recharge the batteries, or connect to an external power source.
* Make sure the power cable is correctly connected to the power port of the receiver.

a. Align the keyways when connecting the power cable to the power port of the receiver.
b. The cable will click when it is secured in the port.

c. To remove the cable, push the cable in, then gently remove it from the power port.

d. Connect the receiver to a different power source.

Recharge the batteries or connect to an external power source using the charging cables and power
adapter shipped with the receiver.




Configuration

The receiver is primarily used for surveying land and construction job sites, and to support static and RTK
applications. You can also log data internally to a non-removable SD card. These logs can be downloaded from
the receiver for static or kinematic surveying, mapping, monitoring, and positioning applications. The receiver uses
different built-in communication technologies to transmit or receive RTK corrections, and to achieve RTK solutions
using field applications like MAGNET Field or Pocket-3D.

The receiver can be configured in a variety of ways, depending on your project requirements. Typically, the
receiver supports the following operation modes:

* static and kinematic post-processing

* NTRIP server and NTRIP caster functionality

* network RTK rover as NTRIP client or TCP/IP client

® UHF base and rover in RTK or DGPS configuration

* LongLink base and rover in RTK or DGPS configuration

* DGPS or RTK repeater

* PPP (Point Precise Positioning) rover

* SBAS rover
The sections in this chapter describe receiver configuration, receiver options, loading a new Option Authorization
File (OAF), updating firmware, and performing a factory reset. To do this, download the Topcon Receiver Utility

(TRU) software from the myTopcon website at https://www.topconpositioning.com/support. For information
about installing the software, see the Topcon Receiver Utility (TRU) Online Help, available in the software.

Viewing Receiver Information

In the Topcon Receiver Utility (TRU), the Receiver Info screen displays basic receiver information, such as
hardware and firmware versions, RAM size, receiver ID, serial number, etc.

To open the receiver window, do the following:

1. Connect the receiver to a computer and open TRU.
2. Click Device » Application Mode » Receiver Managing.
3. Click Device » Connect. The Connection Parameters screen appears (Figure 15).

o e e |

Connect Using

|Serial Port - |
Port Mame
Communications Port (COM1) B

Receiver Port
|| secondary Receiver

Serial A -

[ ]

Figure 15: Connection Parameters

4. Click Connect to establish a connection with the receiver. The TRU main screen appears.
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5. In TRU, click the Information icon. The Receiver Info window appears @)
(Figure 16). g
; ~ =
i Receiver Info 2[-10) x| o
Name Value C
i Receiver —
g Name HiPer HR Q)
«@ Frmware Version 5.1 r_-_l-'
by otz g
Information R—
@ Model B310

ld w2222

@ Serial Number 5TP222

@ Version B310_7

@ Hardware Version 0

@ Power Board
@ Frmware Version  10b
@ Hardware Version 3

e Linux
g Version unknown
@ Buid Time unknown

L dedl]
#® Frequency, MHz 250

SBHRAM Size, KB 16,384
= Device Storage
=3 Total Capacity, GB 7.44
= Avaiable Sze, GB  7.44
S)Free Size, GB 6.30
Flpattery A, V 4.10 (96%)
Flpattery B, V 7.86 (81%)

@Power Supply, v 11.80
@Power Board, V 11.50

Save to File

Figure 16: TRU — Receiver Info
Loading New Firmware

This section describes how to update firmware on the HiPer HR with a USB connection. To connect the receiver
to your computer, use a micro USB cable (p/n 1013602-01) and USB drivers installed on the computer. USB
drivers and firmware are available at https://www.topconpositioning.com/support.

After plugging the receiver into to the computer, the operating system will report a new external device has
been found. It will be assigned to a virtual COM port. You may check its number in the Windows Device
Manager (Figure 17).

s T T T —

i Device Manager s S Sum———
File Action View Help
&= | HEl®

4 T3 ports (COM & LPT)
Y% Gadget Serial (COM18)

Figure 17: Device manager

This virtual port is used for loading new firmware. You can also update the firmware using a physical COM port
or high speed wireless connection via Wi-Fi or Bluetooth. Loading firmware using a physical COM port takes
longer than using TRU. Therefore, Topcon does not recommend using physical a COM port.

Receiver board firmware is released as a file with “*.tfi” extension. Topcon Receiver Utility ver 3.2 and higher
supports loading of files with “*.Idr”, “*.Idp”, “*.tar”, “*.tfi" extensions.
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To upload firmware files to the receiver, do the following: @)
1. Connect the receiver to a computer using a Micro USB cable. 8
2. In the Windows Device Manager, check the number of the virtual COM port. °=dh
3. Start TRU on your computer. E
4. Click Device » Application Mode » Firmware Loading, to set TRU to the firmware loading mode. =
5. Click Device » Connect. The Connection Parameters screen appears (Figure 18). o
6. Select Serial Port from the Connect Using drop down list (Figure 18). =)
7. Click the [-| button. The Select Port screen appears (Figure 18).
8. Select the Gadget Serial port for USB communication, and click OK. The Connection Parameters
screen appears.
i B i ™
., Connection Parameters 7| _| 0| x| ., Select Port ?lod _| O] x|
~Lonnect Using Friendly Mame Physical Name
|Serial Port - fA Nuvoton Communications Port (COM1) \\.\COM1
Port Mame
Gadget Serial (COM18) B

Receiver Port
|| secondary Receiver

Serial A -

Figure 18: Connection Parameters/Select Port

9. Click Connect to establish a connection with the receiver. The Firmware Loading screen appears.
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10. Click the Firmware Loading icon. The Select Device screen appears (Figure 19). @)
o}
. -
- =)
Device Type Og
B 5 —
’Recewer 5 Information il;lglil 9-,'.
Modem Firmware Format o]
Narme Value 3
@ Target Device Receiver
Receiver Port 8 Racaiver
Internal Modem «@ Name HiPer HR
Serial C «@ Firmware Version 5.1 Dec,29,2015 b3
@ Vendor Topcon
Capture Method
Soft Break «# GNSS Board
w2 Model B310
Serial Port Settings w2 Id w2222
% Serial Mumber STP222
o Version B310_7
— — E «@ Hardware Version 0
[
[ <Back |[ nNea> | [ Cancel

[

Figure 19: Select Device/Device Information

11. Click Next. The Information screen appears (Figure 19).
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12. Click Next. The Select Files screen appears (Figure 20). @)
@)
- Setet s #-]alx] =
Image: 0Q
mage: C
=2
@)
o
. Z-jox] |
Current Status:
[pone
- ™
[ <Back ][ Net> | [ Cancel
[ TRy =X=)

. The receiver is updating its firmware. Do not turn off the receiver
" !*-, until the firmware has been updated.

: Finish

Figure 20: Select Files/Install

13. Click the < button and browse for the receiver’s *.tfi file.
14. Click Next. The Installation screen appears and the firmware begins uploading (Figure 20).

15. When the progress bar is filled with green, click OK in the dialog box. TRU automatically disconnects from
the receiver.

Option Authorization Files

Topcon issues an Option Authorization File (OAF) to enable the specific options that you purchased. Topcon’s
OAF system allows you to customize and configure the receiver according to your particular requirements,
therefore purchasing only the options you need.

The HiPer HR receiver is typically shipped with an OAF as per initial purchase of the receiver kit configuration.
There are several upgrade options available with the receiver that can extend the receiver’s functionality to
better suit your job requirement. Examples of upgrade options are listed below:

* GPS L1, L2, L5 signal tracking

® GLONASS L1, L2, L3 signal tracking

* BeiDou B1, B2, B3 signal tracking

® QZSS L1, L2, L5 signal tracking

® SBAS L1, L5 signal tracking

® QZSS L1, L2, L5, Lex signal tracking

* Galileo E1, E5 signal tracking

* RTK and update rate 20 Hz (10 Hz standard)

* Precise Position Mode (Code, Float, Fixed, Terrastar)

Contact your Topcon dealer or a customer representative for a complete listing of available options and pricing
information.
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Checking the Receiver’'s OAF

1. Connect the receiver to a computer and open TRU. See the 7opcon Receiver Utility ( TRU) Online Help for
more information about connecting the receiver to a computer.

2. In TRU, connect to the receiver.
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3. Click the Options @ icon in the main screen. The Receiver Options window (Figure 21) displays, so
you can view the current authorization options and upload new ones.

r

= Recsiver Options: =T
Friendly Name Current Permanent Leased o
Tracking
11,12, L5 L1, 12,15
11,12, L3 L1, 12, 13
El, E5 E6 El, E5, E6
| Elsenou B1, B2, 83 B1, B2, B3
JAS L1, L5 L1, L5
755 L1, L2, L5, LEX Tracking, LEX Decoding L1, L2, L5, LEX Tracking, LEX Decoding
Il tellite Tracking Channel Count 448 72 448
=|Duzl Antenna Tracking Yes No Yes =
Cmop Tracking Yes No Yes W
E]Quaru Locked Loop Yes No Yes
Adaptrve PLL Yes No Yes
Mumpath Reduction Yes No Yes
E]Raw Measurement Update Rate, Hz 100 0 100
Positioning
[Eloanss Made Yes No Yes
[ElrTK Positioning, Hz 100 Disabled 100
RTK Vertical Accuracy Level, cm 1] [1] [1]
RTK Horizontal Accuracy Level, cm 0 1] 1] b
E]Max\mal Baseline Length, km No restrictions Disabled Mo restrictions
HDZ Mode Heading and Pitch Disabled Heading and Pitch
[Elp1on Made Yes o Yes
E]AutuSeed Mode Yes No Yes
[ElomnisTAR Service VBS, XP, HP, G2 Disabled VBS, XP, HP, G2
Pre:lse Positioning Mode Code, Float, Fixed, Veripos Disabled Code, Float, Fixed, Veripos
Yes Mo Yes
sition Update Rate, Hz 100 ] 100
Interfaces
=|Memory, MB No Restrictions 0 Mo Restrictions
PPS Timing Signal Double No Double
ent Markers Single No Single
rial Port A Max Baud Rate 460,800 Disabled 921,600
rial Port B Max Baud Rate 460,800 Diszbled 921,600
Senal Port C Max Baud Rate 460,800 Disabled 921,600
rial Port D Max Baud Rate 460,800 Disabled 921,600
hernet Port Yes No Yes
EWLAN Client, Access Point Disabled Client, Access Point - |
L 4

Figure 21: Receiver Options
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Loading an OAF o
3
Topcon dealers provide customers with OAF files. For any OAF related questions, e-mail Topcon at °=-q"
options@topcon.com and include the receiver’s ID and serial number. To obtain these numbers, see “Viewing c
Receiver Information” on page 31. o
(=
1. Follow the steps in “Checking the Receiver’'s OAF” above. o
2. Right-click on the Receiver Options window, and select Upload OAF (Figure 22). =)
Enec\eiveromiuns _?I;Ig&
Friendly Name Current Permanent Leased il
Tracking
[Elers
[EleLonass
Gal\leo
Be\Dou
[E]seas
[Eazss |
Satelhte Tracking Channel Count 72 72 72 =
Dua\ Antenna Tracking No No No
Cu»inrackmg No No No
Quanz Locked Loop No MNo No
[E]adaptive pLL No No No i
Multlpath Reduction No No No I
Raw Measurement Update Rate, Hz 0 0 i)
Positioning
[Elocnss Mode No No No
RTK Positioning, Hz Disabled Disabled Disabled
RTKVerticaI Accuracy Level, cm 999 999 999
RTK Horizontal Accuracy Level, cm 999 999 999
MaxAmaI Baseline Length, km Disabled Disabled Disabled o
HDZ Mode Disabled Disabled Disabled Sxes 4
[E]p1on Mode No No o |
EAuroSeed Mode No No No | SERES U
DmmSTAR Service Disabled Disabled Disabled ieny ' 0
Prec\se Positioning Mode
[nemal Integration No No No
Pos\t\on Update Rate, Hz 1] 0 1]
Interfaces
[E]memory, ms 0 0 0
1-PPS Timing Signal No No No |
Event Markers No No No
Sena\ Port A Max Baud Rate 115,200 Disabled Disabled o |J

Figure 22: Right-click and Select Upload OAF

3. Navigate to the location of the new Option Authorization File.
4. Select the appropriate file, and click Open (Figure 23).

+ 9 I E
Organize v New folder = 0 @

sk Eavorites Marne Date modified Type

|| WOCIL43L5ALtpo 15-Feb-1615:28 TPO File |

4 Libraries
1M Computer

“i Network

4| |

File name: WOCH43L5ALtpo - [Optiuns Files (*.t

[ open |

Figure 23: Load OAF

TRU initially checks to see if the selected file is compatible with the currently connected receiver. If you chose
a file not intended for this receiver, the Upload OAF window displays an error icon next to the Receiver ID,
and disables the Upload the File to the Receiver button.
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5. Click Upload the File to the Receiver to start loading the file (Figure 24).

[ Upload OAF ngg
B

Property Value

uoneindyuod

[Flzeriaig NA

[=|ReceiverD XX-00000(XX

EMudel NN =00000-X Universal Turbo
(=] chedksum 5640

EDealer Topcon Positioning Systems, Inc.
=] Emai YXO(KX @topcon, com
ESubmitTlme 2016-02-02 13:10:43
ECipher Digest

Figure 24: Upload OAF to the Receiver

6. Click Yes at the prompt to reset the receiver (Figure 25). The Connection Parameters screen appears.

-

ﬂ‘;
TRU o

—

F e
@ The changes will take effect after reset. Reset the receiver?
-

Yes Mo

Figure 25: Reset Receiver
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Click Connect (Figure 26). The TRU main screen appears.

-

@L‘nﬂﬂ:lilm Parameters
Connect Using

210/ x|

|Serial Port

v

Port Name

Communications Part (COM1)

Receiver Port
[ | secondary Receiver

Serial A

(-]

[

Figure 26: Connect to the Receiver

7. Click the Options icon. The Receiver Options screen appears (Figure 27).
8. Check the following conditions:
* If you uploaded a universal OAF, make sure the expiration date is still valid.

¢ If you uploaded a customer OAF, make sure the correct customer file is loaded.

Option Authorization Files

.

= Recerer O

Friendly Name

Elars

ElcLonass

E}Gah\eu

I E]Ee\Dou

Elssas

Elozss

i E}Satelhte Tracking Channel Count
E]Dual Antenna Tracking
E]Co—op Tracking
E}Quam Locked Loop
[Eladaptive PLL
E}Mu?tlpath Reduction

Elpsniss Mode

E}RTK Positioning, Hz

E}RTK Vertical Accuracy Level, cm
E}RTK Horizontal Accuracy Level, cm
E}Maxlmal Baseline Length, km
[ElHD2 Mode

Elp1on Mode

E}Autosaed Mode

E]DmmSTAR Service

E]Pre(se Positioning Mode
E]Iﬂertlal Integration

E}Puslt\on Update Rate, Hz

E}Memory, MB

E]l-PPS Timing Signal
E]Eveﬂt Markers

E}Sera\ Port A Max Baud Rate
E}Sera\ Port B Max Baud Rate
E}Sera\ Port C Max Baud Rate
E}Sera\ Port D Max Baud Rate
E}Ethemet Port

Elwian

Current
Tracking

L1, L2, L5, LEX Tracking, LEX Decoding

Yes

E]Raw Measurement Update Rate, Hz 100

Positioning
Yes
100
o
o
Mo restrictions
Heading and Pitch
Yes
Yes
VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes
100
Interfaces
No Restrictions
Double
Single
460,800
460,800
460,800
460,800
Yes
Client, Access Point

Permanent

2l -|olx]

Leased

L1, L2, L5
L1, L2, L3
El, E5 E6
B1, B2, B3
L1, L5

L1, L2, LS, LEX Tracking, LEX Decoding
448

Yes

Yes

Yes

Yes

Yes

100

m

Yes

100

0

0

No restrictions
Heading and Pitch
Yes

Yes

VBS, XP, HP, G2
Code, Float, Fixed, Veripos
Yes

100

No Restrictions
Double

Single
921,600
921,600
921,600
921,600

Yes

Client, Access Point -

Figure 27: Receiver Options Screen
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9. To view additional OAF details, right-click in the Receiver Options window and select View » Detailed
(Figure 28).

Q
©)
3
. _ _ _ . =h
[~ cemrcpsns #_Jolx] 0
Friendly Name Current Permanent Leased ; | C
Tracking -
[Elers
(=
[E]cLonass —
Ga\i\eo O
zgf;u Refresh 3
Upload OAF
QZSS SavetoFile ¥ E
SateHite Tracking Channel Count 224
Dua\ Antenna Tracking Yes O GreviEn
Co—op Tracking Yes
Quartz Locked Loop Yes Mo Yes
Adaptwe PLL Yes No Yes
Mumpath Reduction Yes Mo Yes
Raw Measurement Update Rate, Hz 100 0 100 L
Positioning
[Eloenss mode Yes No Yes
RTK Positioning, Hz 100 Disabled 100
RTK Vertical Accuracy Level, cm 0 999 0
RTK Harizontal Accuracy Level, cm 0 999 0
Maxima\ Baseline Length, km Mo restrictions Disabled No restrictions
HDZ Mode Heading and Pitch Disabled Heading, Pitch and Roll
D]DN Mode Yes No Yes
AutuSeed Mode Yes No Yes
[ElomnisTar service VBS, XP, HP, G2 Disabled VBS, XP, HP, G2
Precise Positioning Mode
Inema\ Integration Yes Ho Yes
Fosltlon Update Rate, Hz 100 0 100
Interfaces
Memnry, MB Mo Restrictions 0 No Restrictions I
17PPS Timing Signal Double No Double
Event Markers Double No Double
Serlal Port A Max Baud Rate 460,800 Disabled 921,600 L
= .

Figure 28: Additional OAF Details
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Performing a Factory Reset

The receiver’s Non-Volatile Random Access Memory (NVRAM) holds data required for satellite tracking, such as
ephemeris data and receiver position. The NVRAM also keeps the current receiver’s settings, such as active
antenna input, elevation masks and recording interval, and information about the receiver’s internal file system.
A factory reset clears the receiver’'s NVRAM and restores the receiver’s factory default settings. Factory reset
takes about 1-2 minutes to perform.

uoneindyuod

Although a factory reset or clearing the NVRAM is not recommended as a common practice, there are times
when it can eliminate communication or tracking problems.

After a factory reset, the receiver requires time to collect new ephemerids and almanacs (around 15 minutes).

A factory reset will not delete any files already recorded in the receiver’s memory, and the NVRAM keeps
information about the receiver file system. The process takes approximately two minutes.

There are two ways you can perform a factory reset: using TRU and using the LED display panel.
Perform a Factory Reset Using TRU

1. Connect the receiver to a computer, and open TRU. See the 7opcon Receiver Utility (TRU) Online Help for
more information about connecting the receiver to a computer.

2. In TRU, connect to the receiver.

3. Click the Tools icon in the main screen. The Tools window appears, enabling you to reset the receiver
and clear the NVRAM (Figure 29).

+ Tools 2l -10) x|

Reset Receiver

Q Factory Reset })

Reset Parameters AC%, After resetting, the receiver will require some time to re-collect data
¥ needed to track satellites, Continue?

Reset RTK

Power Off

Sleep

Reset VISOR

Figure 29: Tools Window

4. Click Factory Reset, then click Yes at the prompt.
Perform a Factory Reset Using the LED Display

Press and hold the Power button for 10-15 seconds.
Release the Power button when STAT LED turns magenta.
Wait until the STAT and REC LEDs blink orange.

Wait until the STAT and REC LEDs turn green.

HwON=
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Using the Web interface

The HiPer HR receiver includes a built-in Web server that allows you to configure and monitor the receiver with
a Web browser. Topcon recommends the following Web browsers:

¢ Internet Explorer 6.0 or later

® Opera 9.0 or later

* Google Chrome

* Mozilla Firefox 2.0 or later
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Configuring Network Parameters

To access HiPer HR Web interface, configure the receiver as a Wi-Fi access point and connect to it, or connect
the receiver and your computer to the same Wi-Fi network. This section describes how to configure the network
parameters of the receiver.

1. Connect the receiver to a computer and open TRU.

2. Click Device » Application Mode » Receiver Managing.
3. Click Device » Connect. The Connection Parameters screen appears (Figure 30).

B 7l olx]|

Connect Using

| seril Port v |
Port Name

Communications Port (COM1) B
Receiver Port

[ 5econdary Receiver

Serial A -

[ 'l

Figure 30: Connection Parameters

4. Click Connect to establish a connection with the receiver. The TRU main screen appears.
5. In the TRU main screen, click the Receiver Settings icon. The TRU receiver settings screen appears.
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6. In the TRU receiver settings screen, click the Network icon. The Network window appears. @)
(Figure 31). g
r =h
— — i Network 0q
w Lh | Bthemet | Wi-Fi | TCP | TCP Cient | HTTP | FTP | PPP_| E
. — = . Mode: [Access Point gl"
Receiver Access Point (@)
Settings Network SSID: HiperHR11 S
Password: ppSSWW

IP Address: 111 .222 . 3 ., 4
Mask: 255 . 255 . 255 . 0

[|Don't broadcast 551D

Client

SSID: TOPCON

Password: 1234567

IP Address: e . e .0 . 0

L

Figure 31: TRU — Receiver Network Parameters, Wi-Fi Tab

7. In the Network window, open the Wi-Fi tab.
8. Make the required configurations for the mode you need. See the sections below for details.

Configuring Receiver as an Access Point

This section describes how to configure the receiver as a Wi-Fi access point. Before you begin, complete all
steps described in “Configuring Network Parameters” on page 42.

1. Select Access Point from the Mode drop down list. Fields in the Access Points group box are active.
2. Specify the network name in the SSID edit box. Enter a meaningful name.

3. Specify the password for the network in the Password edit box.
4

Specify the IP address of the receiver’s access point in the IP address edit box. This IP address is used to
access receiver’s Web interface.

If needed, specify the network mask of the access point in the Mask edit box.

6. If needed, select the Don't broadcast SSID check box. In that case, specify the network name manually
to connect to it.

7. Click OK.

b

Configuring Receiver as a Client

This section describes how to configure HiPer HR receiver as a client. Before you begin, complete all steps,
described in “Configuring Network Parameters” on page 42.

1. Select Client from the Mode drop down list. Fields in the Client group box are active.

2. Specify the name of the required network in the SSID edit box.

3. Specify the password of the network in the Password edit box.

4. Click OK.

5. In the TRU receiver settings screen, click the Network icon. The Network screen appears.
(Figure 31).

6. Open the Wi-Fi tab.

N

Write down the IP address of the receiver from the IP Address field of the Client group box. This IP
address is used to access receiver’s Web interface.
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Accessing the Receiver Though the Web Browser

Before accessing the receiver using the Web browser, make sure the network parameters (SSID, IP address,
and so on) are specified in the receiver, as described in “Configuring Network Parameters” on page 42.

To open the Web interface:
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1. Connect to the receiver, working in the access point mode; or connect to the same Wi-Fi network as the
receiver.

2. Open your Web browser.

3. In the address or location bar of the Web browser, type the following address: Attp.//ipaddress, where
[paddress is the IP address of the receiver for the connection type in use. The click Enter
The login page displays (Figure 32).

HIPER HRrR

’;

[

PASSWORD

LOGIN

GUEST LOGIN

TOPCON

Figure 32: Main Page of the HiPer HR Web Interface

4. Enter the login and password to access the Web interface.
The default user name and password are admin. User name and password are case sensitive.

5. Click LOGIN.

/gs You can access the receiver without entering the user name and password by clicking GUEST
< . ; ;
@ LOGIN; however, you are restricted to view-only access.
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Using TILT Correction Technology

The receiver contains the internal Electronic Level and Compass (ELC) module, which allows you to perform the
following tasks.

* Determinate the tilt angle of the pole and transmit the value to the field software. The software will calculate
the true coordinate of the measured ground point. You can activate this mode using MAGNET Field
(version 4.0 and higher). For 7opo, Autotopo and Stake survey, MAGNET Field uses the till angle of the pole
from the ELC to calculate the offset of the phase center GPS antenna in the horizontal plane, for each GPS
epoch. These offset values are used for obtaining the true coordinate of the measured ground point. This mode
wiIIdwork if the current tilt does angle not exceed the value in the Tilt Correction Limit field. To activate this
mode
(Tilt Correction mode) select the check box in the Tilt Correction Limit field, and specify the
corresponding angle.
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Till pole
angle

True projection | False projection
of the Phase Center of the Phase Center

JTTIV 77

l
Offset dN/dE
e———— |

I
Figure 33: Tilt Correction Mode

¢ Automatically start the measuring of a point if the pole tilt value was less than one degree during the time
interval longer than the Auto Store After value (by default it is two seconds). To activate this mode (Auto
Store mode) select the check box in the Auto Store After field, and specify the corresponding time interval.
In this mode, Tilt Correction mode can be can work with activated or deactivated.
When the mode is deactivated, if the till pole is at an angle which exceeds the value in the Tilt Filter Limit
field, the epoch counter will stop. To continue the measurement, set the pole vertically.

When the mode is activated, MAGNET Field calculates the offset of the phase center GPS antenna in the
horizontal plane, for each GPS epoch; however, the current till pole must not exceed the value in the Tilt
Correction Limit field.
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¢ Show/hide graphic view of the bubble level. After selecting the Show eLevel check box, the bubble level will
be shown on the 7opo, Autotopo and Stake dialogs for GPS configuration only.

The graphic view of the bubble level depends on whether tilt correction mode is on or off.

Q
©)
)
=
09
c
=
Q
=
o
)

* Show/hide the value of the external magnetic field in the graphical and text view in the 7opo, Autotopo and
Stake mode (when Map View is selected).

Using MAGNET Field or TRU, you can perform the electronic level calibration procedure and the compass
calibration procedure.

Calibrating the ELC

The ELC inside the receiver provides 3-axis monitoring of the earth's magnetic field to deliver azimuth data. Due
to characteristics of the e-compass used in this technology, field calibration is required.

The calibration procedure consists of the following steps:

1. Calibrate the electronic level of the receiver.
2. Calibrate the magnetic compass of the receiver in 3D.
3. Calibrate the magnetic compass of the receiver in the horizontal plane.
Calibration is performed independently and sequentially. After all three calibrations are finished, the ELC is ready
to use.
Topcon recommends the following to calibrate the ELC:
a. Calibrate the ELC in the field, after the receiver has tracked satellites and determines a position.
b. Connect the receiver to a controller via Bluetooth or Wi-Fi.
c. Before calibrating, turn on and/or attach all equipment which will be used for the survey. For RTK
survey, receive the corrections data using the desired modem and obtain the Fixed solution.
— if you use UHF or FH modems, connect the radio antenna and turn on the radio modem;
— if you use both batteries for the survey, attach the removable battery;
— do not use an external power source.
You can use MAGNET Field or TRU to calibrate the ELC module.
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Calibrating the Level

For accurate level and compass readings, perform the electronic level calibration procedure. You will need a
universal tribrach, tribrach adapter, and 100 mm aluminum prism spacer (Figure 34).
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Hiper HR

Rotating
Tribracht
Adapter

<«— Tribracht

Figure 34: Electronic Level Calibration

1. Set up a tripod with the universal tribrach and tribrach adapter.

Level the tribrach, and place the receiver on the tribrach adapter with the prism spacer to eliminate
vibrations during calibration. The receiver will track satellites and determine its position.

3. Click the Calibrate button in the Level field to start the procedure.
4. Wait for 30 seconds.

If calibration succeeds, the application will show the date and time of calibration. If calibration fails, the field
will show the date and time of the previous successful calibration and the £ icon.
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Calibrating the Compass in 3D

To take an accurate compass reading, perform the compass calibration procedure for each location before
starting the survey. Make sure to calibrate the level before calibrating the compass.

1. Hold the receiver flat with the GNSS antenna radome pointed up, and the LED display panel pointed to
you.

2. Click the Calibrate button in the Compass field to start the procedure.

3. Rotate the receiver 360 degrees in the vertical plane along the X axis (Step 1 of Figure 35).
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Figure 35: Calibrate Compass in 3D

4. Rotate the receiver approximately 45 degrees to the left in the vertical plane along the Y axis, then rotate
the receiver 360 degrees in the vertical plane along the X axis (Step 2 of Figure 35).

5. Repeat step 4 until the receiver completes a full 360 degree circle around the X axis

(Step 3 and Step 4 of Figure 35).
If calibration succeeds, the application will show the date and time of calibration. If calibration fails, the field
will show the date and time of the previous successful calibration and the £ icon.
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Calibrating the Compass in the Horizontal Plane

For accurate compass readings, perform the compass calibration procedure in the horizontal plane for each
location before starting the survey. Make sure to calibrate the level, then calibrate the compass in 3D before
you begin. You will need a universal tribrach, tribrach adapter, and 100 mm aluminum prism spacer

(Figure 34 on page 47).

1. Set up a tripod with the universal tribrach and tribrach adapter.

2. Level the tribrach, and place the receiver on a tribrach with the aluminum prism spacer. Maximum
calibration accuracy is possible when the receiver is orthogonal to the horizontal plane and vibrations are
eliminated.

3. Make sure the receiver displays a no-none solution type.

4. If using MAGNET Field, click the Calibrate button in the Compass Alignment field. If using TRU, click
the Align button in the Compass field.

5. Turn the receiver clockwise in the horizontal plane. The indicator shows the time left until the calibration
process completes.

If calibration succeeds, the application will show the date and time of calibration. If calibration fails, the field

will show the date and time of the previous successful calibration and the £ icon.
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During operation, the receiver evaluates the local magnetic environment and alerts a user if a recalibration is
required. These alerts appear in the field software. Recalibrate the receiver when the field software indicates,
and under following conditions:

¢ if the receiver has been off for a long time;

* if the receiver is used for the first time;

* if the survey location changes frequently;

¢ if the receiver took a shock, such as being dropped;

¢ if temperature changes are 10° C or more;

¢ if the receiver was transported by a car or airplane;

* if the receiver was near a strong magnetic object or material, such as a permanent magnet, electromagnet,
electric transformer, AC power supply, etc;

¢ after loading new firmware;
¢ after clearing the NVRAM.
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System Setup

Th

e receiver transmits RTK corrections from the base to the rover receiver using either LongLink™ wireless

technology, or UHF or FM modem. The internal cell module receives correction data from reference GNSS
networks.

Th

is chapter describes the field setup for base or RTK rover usage.

Setting Up the Base Receiver

1.

10.

11,

g
gz

System Setu

Install a heavy-duty tripod (p/n 22-050501-01) over a
known point. You do not need a universal tribrach and
tribrach adapter when working with this tripod.

Position the base receiver over a point with a known
coordinate in the current coordinate system.

Attach the antenna to the UHF or FH modem antenna
connector.

Level the tripod and tighten the screws.

If needed, attach any other accessories, such as a back-up
power supply.

Measure the height of the receiver from the ground using
the tape measure. See “Measuring Antenna Height” on
page 54.

Press the Power button to turn on the receiver. The
integrated wireless device in the receiver turns on when the
receiver is powered.

Run Topcon field software on the field controller, and
connect the Base receiver to the controller using a serial
Port or Bluetooth.

Select the following parameters:
— Select an elevation mask.
— Select the RTK output format.

— Select the radio modem parameters (for UHF modem:
Power, Protocol, Modulation, Spacing,
Scrambling, FEC; for FH modem: Power, Channel,
Protocol, Location).

— Select raw data logging if required.
Set the receiver as a Base in the field software:
a. Enter the name of the point where the Base receiver is located.
b. Enter the coordinates of the point.
c. Click Start Base to set the receiver as the Base, and transmit the correction data.

View the LED display panel for the receiver’s current status. See “Display Panel” on page 13 for more information
about LEDs.

Select the RTCM MSM3 format in the RTK output protocol to create the correction data with
measurements for GPS, GLONASS, BeiDou, Galileo and QZSS satellite systems.
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Setting Up the Rover Receiver

Attach the receiver to the pole. Make sure the receiver locks into place. 1

If you are not using a fixed height rover pole, measure the height of the receiver
from the ground. See “Measuring Antenna Height” on page 54.

3. If using a radio modem, attach the antenna to the UHF or FH modem antenna
connector.

4. If using a SIM card, install the SIM card into the receiver
(see “SIM Card Location” on page 11).

5. Press the Power button to turn on the receiver. The integrated wireless device in
the receiver turns on when the receiver is powered.

6. Run Topcon field software on the field controller, and connect the Rover receiver to
the controller using a serial Port or Bluetooth.

7. Configure the UHF/FH or cell modems.
a. If using UHF/FH, do the following:
— Select an elevation mask.
— Select the RTK input format.

— Select the radio modem parameters (for UHF modem: Modulation,
Protocol, Scrambling, FEC; for FH modem: Channel, Protocol,
Location).

— Select raw data logging if required.

b. If using a cell modem, do the following:

— Select the type of correction data used for survey (VRS, Single Base, or
MAGNET Relay).

— Select the input correction data protocol: TCP/IP, NTRIP 2.0/1.0, or NTRIP 1.0.
— Select an elevation mask.
— Select the RTK input format.
— Select the Internet address and TCP port number of the remote server.
— Enter a User ID and to log in, and configure parameters for a dialup Internet connection.
— Select raw data logging if required.
8. Establish an Internet connection to the remote server, and obtain the correction data.

9. View the LED display panel for the receiver’s current status. See “Display Panel” on page 13 for more
information about LEDs.
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Using the Receiver with an External Antenna

The Hiper HR can be used with an external antenna. Topcon recommends using a Topcon active (with LNA)
external antenna.

Topcon cannot guarantee the correct performance with other brands of GNSS antenna.
Do not use passive GNSS antenna with the receiver.

When an external antenna is used, the receiver supplies a voltage from +4.5 V to +5.5 V to the central pin of
the SMB antenna connector. Maximum antenna current is equal to 120 mA.

To use an external antenna, use MAGNET Field or TRU to set up the external antenna.

Setting Up The External Antenna in MAGNET Field

1. Open MAGNET Field, and click Configure » Application Mode.

2. Open the Config: Base Receiver or Config: Rover Receiver dialog box (Figure 36). The default
antenna is set to HiPer HR.

E] Config: Base Receiver V’ x

v |Ser|'al Cable ‘V‘

Receiver Model |H|'Per HR ‘ hd ‘

Serial Number

Elevation Mask 13 deg

RTK Format RTCM 3.x MSM3 A

Antenna HiPer HR A

Figure 36: MAGNET Field — Default Antenna

3. Select the desired external antenna from the Antenna drop-down list (Figure 37).

@ Config: Base Receiver V/ x

_ |Serial Cable \V,
Receiver Model |HiPer HR ‘ VI
Serial Number
Elevation Mask 13 deg
RTK Format RTCM 3.x MSM3 Bd
Antenna PG-Al n

Figure 37: MAGNET Field — External Antenna Selected

4, Click to save the settings.
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5. Connect the external antenna to the receiver using the external antenna cable (p/n 1006447-01).

@@ Once the external antenna is connected, the receiver will only track GNSS signals.

Setting Up the External Antenna in TRU

1. Connect to the receiver using a serial or bluetooth connection.

2. Click Receiver Settings » Tracking & Positioning. The Tracking & Positioning screen appears with the
Antenna tab active and the default antenna set to Internal (Figure 38).

I

1+ Tracking & Positioning

2[oq _ | Of x|

Antenna [Obe | Positioning | Base | RTK

HDZ

Adv

GMNSS Antenna
(@) Internal

() External

Current Input:
Internal

Auto

Figure 38: TRU — Default Antenna

3. Select External to activate an external antenna.
4. Click OK to save the settings.

5. Connect the external antenna to the receiver using the external antenna cable (p/n 1006447-01)..

<//\»§ Once the external antenna is connected, the receiver will only track GNSS signals.
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Measuring Antenna Height

The receiver calculates the coordinates of the antenna’s phase center. To determine the coordinates of the
station marker, specify the following:

* measured height of the antenna above the station marker

* method of measuring the antenna height

* model of the antenna/receiver used

Any necessary antenna phase center adjustments, based on the antenna model, are automatically applied.
These adjustments, when combined with accurately measured height and measurement methods, allow for
correctly computed reference marker coordinates.

To accurately measure the antenna height, do the following:

1. Measure the antenna height above the control point or marker, either the slant height or the vertical
height.
You may either measure the vertical height to the Antenna Reference Point (ARP) located at the bottom of
the receiver at the base of the mounting threads, or measure the slant height to the Slant Height

Measurement Mark (SHMM) on the side of the receiver. For ARP and SHMM marks on the receiver, see
Figure 39.

2. Record the antenna height, points name, and start time in the field notes.

R=100mm

Phase Ceﬂf><,£l’\

Slant Height
Vertical Height

A - Vertical Offset
C - Slant Offset
R - Radius of the Measurment Point

X

ARP - Antenna Reference Point
SHMM - Slant Height Measure Mark

Figure 39: Antenna Height Measurement Points
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This chapter provides general information about memory, recording data, downloading data, and removing files
to free up memory space.

Memory

The HiPer HR is equipped with an internal SD/SDHC memory card. The 8 GB card is formatted as FAT32. As data
is logged to the card, the REC LED displays the memory capacity status. To access the raw data files on the
memory card, see “"Managing Files” on page 59.

Setting Recording Parameters

You can use one of the following ways to set logging parameters, such as logging rate, types of messages, etc.

* Receiver's Web interface
* Topcon Receiver Utility (TRU) software
* MAGNET Field software

Logging Rates

Memory usage for data logging depends on the logging rate. For more information about setting logging rate
parameters, see the TRU Online Help.

Recording Data

You can log GNSS Raw data to the receiver’s SD/SDHC card, and use the Topcon Receiver Utility (TRU) or MAGNET
Office™ software to download the files to a computer.

Recording Data via the LED Display Panel

To start recording data, using the LED display panel:
1. Press the Power button to turn on the receiver.
2. Wait for the Power LED to become solid green. The receiver is now available to log the raw data.

@@ The receiver is not available to log the raw data until the startup procedure is completed.

3. Press the Power button three times in a row within 2 seconds to start recording.

4. Make sure the REC light blinks green, which indicates a “*.tps” file has opened and data collection has
started. The REC LED blinks each time data is saved to the SD/SDHC memory card. If the REC light blinks
red, the receiver has either a hardware problem, or an improper OAF. See “Option Authorization Files” on
page 35 for more information.

To stop recording press the Power button three times in a row within 2 seconds, and make sure that the REC LED
is dark.

@gg With the Power button, you can record up to 16 raw data files.
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Recording Data via the Receiver Web Interface

To start recording data using the receiver Web interface:

1. Press the Power button to turn on the receiver.

2. Wait for the Power LED to become solid green.

3. Login to the receiver’s Web interface. See “Using the Web interface” on page 42 for details.

4. Open the Receivers Settings » Data Logging page. You can simultaneously start up to 16 raw data
files with the different recording parameters and the Automatic File Rotation Mode (AFRM) option.

5. To configure recording parameters, click CONFIGURE in the required file slot (FILE A - FILE P). The
Configuration page appears.

6. To disable file logging when AFRM is on or started via the Minter, disable the Controlled by AFRM
/Minter check box.

7. Enter the file name in the Filename field, specify the Logging Rate and the Elevation Mask in the
corresponding fields.

8. Click the Start Logging button to start recording data to this file. The Data Logging page reloads, and
the LOG FILES panel displays the status of the log files (Figure 40).
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LOG FILES

DATA ROTATION REMOVE OLD DATA

U PERIOD PERIOD FILES LOGGED

FILEA  /LOGITEST-1 1.00 OFF 0.1493 MB

FILEB /LOGI/TEST-3 0.20 0.0603 MB

FILE C 0 0.0000 MB CONFIGURE

Figure 40: Web Interface — Log Files

9. Make sure the REC LED blinks green.
10. To stop recording, press the Stop button in the required file slot.
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Recording Data Using Topcon Receiver Utility

To start recording data using TRU:

1. Press the Power button to turn on the receiver.
2. Wait for the Power LED to become solid green.

3. Launch TRU, and establish the connection with the receiver in the Receiver Managing mode. See the
TRU Help for more information.

4. Click the File Explorer icon. The File Explorer screen appears (Figure 41).

5. Open the Logs tab. You can record up to 16 raw data files simultaneously, from A to 2 For each file you
can use the its own default settings for logging.

.., File Explorer | ?lled - O] x|

Logs | AFRM | RINEX | FTP Push | Files |

Log | File Name | Fle Size. 8 .Current. Elevation Prefic MINTER&BFRM AFRM.Rota‘tion Use for RIN.EX“
'~ | Logging Period, 5| Mask, * Logging Period. s Period. 5 MINTER & AFRM | Version

A 5 Ida 1 3,600 Yes MNaone

B 5 lab il 3,600 Mo None

C 5 lgc ik 3,600 Mo MNaone

D 5 lgd 1 3,600 No None

E 5 lge 1 3,600 Mo MNaone

F 5 laf il 3,600 Mo None

G 5 lag ik 3,600 Mo MNaone

H 5 lgh 1 3,600 No None

[} 5 Igi 1 3,600 Mo MNaone

] 5 Igj il 3,600 Mo None

K 5 lgk ik 3,600 Mo MNaone

L 5 Igl 1 3,600 No None

M 5 lgm 1 3,600 Mo MNaone

M 5 lan il 3,600 Mo None

0 5 lgo ik 3,600 Mo MNaone

p 5 lap 1 3,600 No None

Figure 41: Logs Tab of the File Explorer Screen

6. Right click on the desired file it to open the context menu.

7. Click Edit to open the Log screen, and specify individual settings such as Elevation Mask, Prefix and
Rotation Period.
You can also select the RINEX version of the current file from the RINEX Version drop-down list. If you
select None, the RINEX conversion will not be enabled.

8. To use these log parameters after pressing the MINTER, select Use for MINTER & AFRM (Figure 42).

-

s -]

.., File Explorer Log lEd = /M =] B3
Logs | AFRM | RINEX | FTP Push | Fles | Current Log: A
: Cument Elevation Elevation Mask, °:
Log | File Name | File Size, B g Fiasd s | Mk
A 5 Prefon: Ida
E- Logging Period, s: 15
c —_— . .
D Start File Logging (Default Settings) Rotation Period, s: 3600 =
E Start File Logaging {Manual Settings) RINEX Version: e =
E Stop File Logging 2
[] Use for MINTER & AFRM
G Advanced MINTER Settings T
H Default Message Set
I Stte Parameters
! Wi
K iEew »

= 4

Figure 42: Context Menu of Logs Tab

9. Click OK to save all changes.
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Using the MINTER, you can start logging one or more files. By default, clicking the Power button three times in
a row within two seconds will log a file. This file is called File A (Figure 44). By default, the Use for MINTER
& AFRM check box is enabled only for File A. You can select this check box for any number of files. In this case,
clicking the Power button will simultaneously start those files for which the Use for MINTER & AFRM check
box is enabled. The current logging files are displayed in the Logs tab (Figure 43).

| File Explorer 2leq - [ol x|
Logs | AFRM | RINEX | FTP Push | Files |
Lo File N Fle Size B Cument Blevation Prefi MINTER & AFEM | AFRM Rotation |se for RIMNEX
9| TEName | Fe S& B ooging Perod, 5| Mask, © ™| logging Period, s | Period,s | MINTER & AFRM | Version
A 5 lda 1 3,600 Mo Mone
B Igbl018.. 14,895 9 12 Igb 9 3,600 2.10
C n lgc 1 3,600 Mo MNone
D lgdi01s.. 21,208 7 7 lod 7 3,600 None
E 5 lge 1 3,600 No Mone

Figure 43: Logs Tab

To start recording data to the selected file with default settings do the following.

1. Right click on the desired file to open the context menu.
2. Click Start File Logging (Default Settings). The current logging file is displaying in the Logs tab

(Figure 44).
[ e Explorr 2lo] [0 x]
Logs | AFRM | RINEX | FTP Push | Files |
Lo File N File Size B Curmrent Bevation Prefi MINTER & AFRM | AFRM Rotation Use for RINEX
d el & 228, Bl | ogging Period. s| Mask. * ™| Logging Period. 5|  Period.s | MINTER & AFRM | Version

Ida1018q000.tps

Figure 44: Start File Logging With Default Settings

You can specify the logging parameters manually. To start recording data to the selected file with arbitrary
settings, do the following.

1. Right click on the desired file to open the context menu.

2. Click Start File Logging (Manual Settings). The Start Logging dialog is opened.

3. Specify the file name and logging period.
4

Click OK to start logging the file using the entered parameters. The current logging file is displaying in the
Logs tab (Figure 45).

Start Logging 2l | Of x|
Current Lo_g
B
File Mame

(") Auto Generate

@) Manualsetting

Loagging Period, 5
(") Defautt: Message Set's Schedule
(") Default Period for MIN

& = .. File Explorer 2lod | O x|
) Logs | AFRM | RINEX | FTP Push | Files |
I File N File Size. B Cument Elevation Predi MINTER & AFRM | AFRM Rotation Use for RINEX
g ikl 1& 128 B | noging Period. 5| Mask, © ™| Logging Period,s|  Period.s | MINTER & AFRM | Version

15 Ida 1 3,600 Mo Nona

A
B | ManualSetting.tps | 8,617 | 90 | 12 ligp| 0 | 3600 | _ Yes _|2.10]
Figure 45: Start File Logging With Manual Settings
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To stop recording data, highlight the desired file, do the following.

1.

Right click it on the desired file to open the context menu.

2. Click Stop File Logging. The Files tab of File Explorer screen displays the list of raw data files stored in

g
gz

the receiver memory.

You can also log data using MAGNET Field software. With MAGNET Field, you can record only one

raw data file at time.

Managing Files

The receiver records TPS data to a storage medium with a FAT32 file system. The files and folders are organized
in a hierarchical structure. A total of 3000 files can be recorded and stored on the storage medium.

You can program the receiver to:

* Record TPS data to up to a maximum of 16 simultaneous files. Each file can be logged with its own parameters.
* Close the current log file and open a new one according to a user-defined schedule. This option is called

Automatic File Rotation Mode (AFRM).

¢ Automatically remove the oldest files to make room for the new files, when AFRM is activated.
¢ Automatically convert the current log file to a RINEX file.
¢ Automatically upload files to an FTP server.

Downloading and Deleting Files

When a survey is completed, you can download data files to a computer for storage, post-processing, or backup.

To download raw data file(s) from the receiver to a computer, do the following.

Select the Files tab in the File Explorer screen (Figure 46). The Files tab displays the list of raw data

1.
files stored in the receiver memory.
2. Right-click on the desired file(s) to open the context menu and select Download (Figure 46).
3. Select the folder where the *.tps file(s) will be saved (Figure 46).
4. Click OK. TRU downloads th selected file(s) to the folder (Figure 46).
[ |4, File Explorer

[Logs | AFRM | RINEX | FTP Push | Fies |

MName
3 lga0131m000.tp

Fi|lgb0127m.tps
[ lgdo127m.tps
lgdo127n.tps

[#]1gb0128h.tps
[¥]1ga03171000.tps
lga0317n000.tps
[#]lgdo128h.tps
[#]1gb1018p.tps

Managing Files

T Size, B Date
Sy 31.01.2017 12:59:42

Refrash

Delete

Upload

Initialize File System
File System Info

Open in Windows Explorer

51208171000 tps

»

3

27.01.2017 12:59:42
27.01.2017 12:59:42
27.01.2017 13:21:34
17.08.2016 11:21:42
28.01.2017 7:28:44

17.03.2017 11:18:22

Browse For Folder

Select Folder

M Desktop
> | Libraries
> |3 Pavel Belikov
4 & Computer
> & Local Disk (C:)
> < Data (D)
> & DVD RW Drive (E;)

1

=

Downloading

Copying the file "lgh0127m.tps" to "D:\"

2ol x|]

Total Progress:

Elapsed:
Rermaining:

00:00:02
00:00:03

[ Make New Folder ] [ oK

[=n

Figure 46: Upload *.tps Files to a Computer
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When the internal memory is full, the receiver stops logging data, and the REC LED turns off, indicating an error
condition. Existing data are not overwritten.
To delete raw data files, do the following.

1. Right-click on the desired file(s) to open the context menu and select Delete.
2. Click Yes to confirm, then click OK. TRU deletes the file(s) from the receiver memory.
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Troubleshooting

This chapter will help you diagnose and solve some common problems that may occur with the receiver.

' Do not attempt to repair equipment yourself. Doing so will void the warranty and may damage the
hardware.

Check This First

Before contacting your local dealer or Topcon Technical Support, check the following:
* Check all external receiver connections carefully to ensure correct and secure connections. Double check for
worn or defective cables.
® Check the receiver’s internal batteries for a full charge.

* Check the power source for incorrectly connected cables, and ensure the power source is valid. See
“Specifications” on page 66 for external power requirements.

* Check the software. Make sure the most current software version is downloaded onto the computer and the most
current firmware is loaded into the receiver. Check the Topcon website for the latest updates.

* (Check Topcon Technical Support (www.topconsupport.com) or Topcon Support
(https://www.topconpositioning.com/support) for the latest updates.

Then, try the following:

* Power on and off the receiver by pressing the Power button or by using TRU (Tools » Reset receiver).

* Restore default settings by clearing the NVRAM. See “Performing a Factory Reset” on page 41. This restores the
receiver’s parameters to the factory default settings and erases the almanac and ephemeris files. This action
does not delete data files from the receiver memory.

If the problem persists, see the following sections for other solutions.

Powering Problems

The following are some of the most commonly encountered power problems.
The Receiver Does Not Power Up
The battery may be discharged.

— Charge the battery overnight. See “Charging the Batteries” on page 28.

¢ If you are using an external power source, the cable may be disconnected or damaged.
— Make sure the cable is securely connected and undamaged.

* The receiver may have a defective charger or defective battery.

— If, after changing the battery or connecting an external power source, the receiver still does not power
up, contact your local dealer or Topcon Technical Support for advice.

If the batteries are charged, reset the hardware using the Hardware Reset button. See “Hardware Reset Button”
on page 12.
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Receiver Problems

The following are some of the most commonly encountered receiver problems.
The Receiver Cannot Establish a Connection to a Computer or External Controller

Cable specific problems:

* The cable is not properly plugged in.
— Unplug the cable, then securely and properly reconnect it to the receiver.
* The cable is damaged.
— Use an undamaged cable. Contact a dealer to replace the cable.
* The USB driver is not installed.
— If you are using a USB cable connection, make sure the USB driver, included on the GPS+ Software
CD, is installed on the computer. You can also download the driver from the Topcon support Website at
www.topcontotalcare.com.
Generic problems:

* The receiver port used for connection is not in Command mode.
a. Connect the receiver to a computer and open TRU (see “Connection” in the 7opcon Receiver Utility
(TRU) Help embedded in the software).
b. Click Receiver Settings » Ports.

C. Change the Input Mode for the port used for connection to cmd.
The receiver does not lock on to satellites for a long period of time
* The corresponding receiver options may be disabled or expired (L1/L2, GPS/GLONASS must be on to track
satellites).

— Order a new OAF with the desired options activated to enable or extend validity of the corresponding
receiver options. Contact a dealer or visit the Topcon website for details.

— Refer to the “"Receiver Managing” chapter of the Topcon Receiver Utility (TRU) Help for a detailed
description of options.

The receiver tracks too few satellites
¢ If the survey is conducted near obstructions (tree canopy, tall buildings, and so forth).

— Make sure the Multipath Reduction boxes have been enabled in the field data collection software.

a. Connect the receiver to a computer and open TRU (see “Connection” in the 7opcon Receiver Utility
(TRU) Help embedded in the software).

b. In TRU, connect to the receiver.

c. On the TRU main screen, choose Receiver Settings » Tracking » Adv tab. Make sure the C/A
code multipath reduction check box is selected.
* Move to an area free of obstructions, if possible.
The receiver cannot obtain Code Differential and/or RTK solutions

8unooyss|qnouy

¢ Incorrect Base coordinates entered.
— Specify the correct coordinates for the Base station using TRU or another suitable field data collection
software.
— There could be some obstruction to the connection.
— Clear all possible obstructions or relocate the Base so there is a “line-of-sight” path to the Rover.
* The corresponding receiver options may be disabled or expired.
— Order a new OAF with the required options activated to enable or extend validity of the corresponding
receiver options.
— Refer to the Topcon Receiver Utility (TRU) Help for a detailed description of options.

* There are not enough common satellites. In order to obtain a fixed solution, the Base and Rover should track
at least five common satellites.

— Check the elevation masks of the Rover and Base receivers; they should be the same. To do this, on
the TRU main window, choose Receiver Settings » Tracking » Obs.

— Verify there is a clear view of the sky to allow sufficient satellite tracking.
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* A discrepancy exists between the differential standards used at the Base and Rover receivers.
— Ensure the Base and Rover receivers use the same corrections input/output format:

a. Connect the receiver to a computer and open TRU (see “Connection” in the 7opcon Receiver Utility
(TRU) Help embedded in the software).
b. In TRU, connect to the receiver.
¢. On the TRU main window, choose Receiver Settings » Ports.
d. Double-click on the port to be configured and make sure the input mode of the Rover matches the
format of the Base output mode (i.e. RTCM3).
Poor satellite geometry (PDOP/GDOP values are too high).
— Conduct the survey where satellite visibility is better (low PDOP value).
— Ensure the elevation mask is less than 10 degrees.
— Increase the PDOP threshold. To do this, on the TRU main window, choose Receiver
Settings » Tracking » Obs.
The elevation mask is above 10 degrees.
— Lower the elevation mask. To do this, on the TRU main window, choose Receiver
Settings » Tracking » Obs.
— Verify there is a clear view of the sky to allow sufficient satellite tracking.
The modem battery is low.

The specified baud rate is incompatible with the baud rates the modem supports. The baud rate is the rate at
which the receiver transmits differential messages to the modem and vice versa.

— Change the modem’s baud rate.
The Base and Rover modems use different radio link parameters.
— Configure the Base and Rover radio modems according to the procedures listed in the 7RU Help.
The distance between the Base and Rover is too far.
— Close the distance between the Base and Rover.
— Use repeaters to increase radio coverage.
There may be a source of radio interference that disrupts radio communications.
— Change the RF channel (if possible).
— Removing the source of the jamming signal or relocate the radio antennas (if possible).
The receiver does not start logging data

* The receiver's memory is disabled or expired.
— Make sure the memory option is enabled. For details, see the Topcon Receiver Utility (TRU) Help.
* The memory card does not have free space.
— Download and/or delete data files to free up space for new files. See “Downloading and Deleting Files
on page 59.
— The file system is not initialized. Initialize the File System on the SD card using TRU. To do this, on the
TRU main screen, choose File Explorer » Initialize File System.
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Bluetooth Problems

The following are some of the most commonly encountered error messages and other problems.
TRU error message: Can't find receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.
Bluetooth is not turned on; the BT LED is off.
— Reset the receiver to the factory default settings by pressing the Power button for 10 to 15 seconds.
— You can also turn on power to Bluetooth using TRU. To do this, on the TRU main window, choose
Receiver Settings » Bluetooth.
* There is interference.
— Move the receiver, controller, or computer to an unobstructed location.
* The receiver is too far away.
— Move the devices closer together.
* The receiver is already connected via Bluetooth to another device.
— Disconnect the receiver from the other controller or computer.
* The receiver port used for connection is not in Command mode.
a. Connect the receiver to a computer and open TRU (see “Connection” in the 7opcon Receiver Utility
(TRU) Help embedded in the software).
b. Click Configuration » Receiver » Ports.

¢. Change the Input Mode for the Bluetooth serial port used for connection to cmd.
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~ This is the most common cause for this error message. Use TRU to double check the settings for the
= connection port.

TRU error message: Open COM# port failed: Access is denied

* Another application uses the computer port dedicated for connection.
— Close the application, and then re-connect.
— Connect the receiver via another, unused computer port.
After searching for available devices, none are discovered

* The receiver is not receiving power.
— Check that the receiver is getting power and is turned on.
— Check that the power cable is correctly attached to the port if one is being used.
— Unplug the cable, then securely and properly reconnect it to the receiver.
— If the power cable is damaged, contact a Dealer to purchase a new cable.
Can see the icon for the receiver’s Bluetooth module on the computer screen, but cannot connect
toit
* Device security settings probably differ.
— Make sure the Bluetooth enabled devices use the same security settings.
* Bluetooth module settings may have changed.
a. If the settings are changed for the Bluetooth module, remove it from the list of discovered
Bluetooth devices using the Bluetooth manager program (supplied with the device used to
manage the receiver).

b. Repeat the search.
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TRU Problems

The following is the most commonly encountered TRU problem.
TRU cannot connect to the receiver

* The receiver is turned off.
— Ensure the receiver has power and is turned on.
¢ If using a cable, the cable’s connectors are improperly attached.
— Check that the cable connector is attached to the correct serial port.
— Unplug the cable, then securely and properly reconnect it to the receiver.
* If using a cable, the cable is damaged.
— Use an undamaged cable.
— Contact a dealer to purchase a new cable.
¢ If using Bluetooth wireless technology, the incorrect port is selected.
— Use a computer or receiver that has Bluetooth wireless technology enabled/installed.
— Make sure the computer and receiver use the correct ports for communication. For the HiPer HR
receiver, this is Bluetooth serial port A (btsp\a).

Cleaning and Storing the Receiver

* Use a clean cloth moistened with neutral detergent or water.
* Never use an abrasive cleaner, ether, thinner benzene, or other solvents.
* Always make sure the receiver is completely dry before storing it. Dry any moisture with a soft, clean cloth.

Getting Customer Support
If the troubleshooting hints and tips in this operator’s manual fail to remedy the problem, contact your local

Topcon dealer or visit the Topcon Support Website (https://www.topconpositioning.com/support) for technical
support. For contact information, see “Getting Technical Support” on page 4.

TRU Problems P/N: 1010117-01
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Specifications

This chapter provides specifications for the HiPer HR and its internal components.
General Details

Table 15 lists the receiver’s general specifications.

Table 15. General Receiver Specifications

Physical
Enclosure Magnesium Alloy housing
Color Topcon Yellow / Gray bumper
Dimensions (mm) 115 (w) x 132 (h) x 115 (d)
Weight 1,172 g with batteries, 1,032 g without batteries
GNSS Antenna Internal/External integrated full wave Fence Antenna™
Technology with internal ground plane
Battery Internal and removable external (with support of run charge
and hot swappable features)
Seals Silicon (molding in color)
Key 1 Power Key — On/Off and Start/Stop Data Logging
LEDs Nine status LEDs:
e Power
o STAT
e REC
o Wi-Fi
¢ Radio
e BT
e Cellular
e BATT Internal
e BATT External
Ports 5 Ports:
e Power
e Serial
e USB
e External GNSS antenna
¢ External Radio antenna
SIM Card Secured and User accessible
(inside external battery compartment)
Environment
Operating Temperature Data logging and logging with external power
e -20° C to +50° C (Battery power/Non-charging)
e 0° Cto +45° C (External power supply/Battery charging)
e -40° C to +65° C per MIL-STD 810G
Storage Temperature -20° Cto +85° C
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Table 15. General Receiver Specifications

Humidity

100%

Ingress Protection

Dust and water ingress protected (IPX7 and IP6X)

Vibration Random: Compliance with MIL-STD 810G - 514.6 - Cat.24
Mechanical: Compliance with MIL-STD 810G - 516.6

Drop Survive 2m pole drop onto concrete surface
Survive 1m handle drop

Power

Batteries Internal: Li-ion, 5200 mAh, 3.7 V;
External: Li-ion 2900 mAh, 7.2 V

Battery Size 110 x 40 x 40 (mm)

Battery Weight 150 g (1 battery)

Operating Time

"

Average with modem “on
and 20 SVs tracked.

Using new, fully-charged
batteries, operating at
room temperature and
transmitting at 1 Hz rate.

For the HiPer HR with R2 Lite FH915 Modem:
¢ Receive-only mode — 4 hours 30 min

¢ Transmitting at 250 mW — 3 hours 15 min

e Transmitting at 1 W — 2 hours 30 min

e GSM/GPRS in urban areas — 4hours 30 min
For the HiPer HR with R2 Lite UHF Modem:

¢ Receive-only mode — 4 hours 15 min
e Transmitting at 0.5 W — 3 hours 45 min
e Transmitting at 1 W — 3 hours 30 min

e GSM/HSPA in urban areas — 4 hours 15 min
For the HiPer HR with Any Modem:
Modem off — 5 hours

External Power

ODU-5

Input Voltage

9 to 28 VDC
Internal Battery (3.7 V, 5200 mAh)
External Battery (7.2 V, 2900 mAh)

Battery Operating Time

e GGD Standalone: 5 hours

GGD UHF Rover: 4 hours 15 min
e GGD UHF Base: 3 hours 30 min
¢ G5 Standalone: 5 hours

e G5 UHF Rover: 4 hours 15 min
e G5 UHF Base: 3 hours 30 min

Battery Charge

Connect the AC adapter to charge the internal battery.

External battery must be removed, and charged with a
recommended charger.

Charging Time

Approx. 4 hours for full charge using manufacturer-supplied
battery charging cradle (p/n 1010975-02) and adapter
(p/n 1005556-01).

On-board

Backup battery for timekeeping and almanac data storage;
minimum 10 years of operation

General Details
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Table 15. General Receiver Specifications

GNSS Receiver Board Details

Number of Channels

448 GNSS channels Vanguard Technology™ with Universal
Tracking Channels?

Tracked Signals

GPS: L1 C/A, L1C, L1P(Y), L2P(Y), L2C, L5
GLONASS: L1 C/A, L1P, L2C/A, L2P, L3C
Galileo: E1, E5a, E5b, E5AItBOC, E6
BeiDou: B1, B2, B3 with ICD availability
IRNSS: SPS-L5

SBAS: WAAS/EGNOS/MSAS

QZSS: L1 C/A, L1C, L2C, L5, LEX

L-band: 1525-1560 MHz

Tracking

Multipath Reduction

Yes, code and carrier

PLL/DLL Settings

Bandwidth, order, adjustable

SBAS

WAAS/EGNOS/MSAS

Quartz Lock Loop (QLL)

Protection against vibrations

Data

usB USB Micro-A/B
Host Mode — USB flash drive
Device Mode — Mass storage, virtual serial

Formats TPS proprietary, RTCM SC104 ver. 2.X, RTCM 3.X, CMR/CMR+,
BINEX

Features Up to 20 Hz update rate for real time position and raw data

ASCII Output

ASCII output NMEA 0183 version 2.x, 3.x, and 4.x

Data Logging

Support for sixteen simultaneous sessions
Advanced file/folder system

RINEX

Onboard RINEX conversion

I/0 Signals

1pps (combined with Serial A)

Communication

Optional Radio Type

Integrated UHF (410-470 MHz), 12.5 kHz spacing (Satel, PDL,
TrimTalk protocols)

UHF Radio Range: 5-7 km typical; 15 km in optimal
conditions?

Integrated Spread Spectrum (915 MHz), FH915 & FH915+
protocols

Memory
Type of Memory SD (Secure Digital) non-removable card
Capacity 8 GB pre-installed

Number of Files

up to 3000

Logging Size

6.0 MB per hour (32 SVs, 1 sec, L1/L2, default message set)

Logging Interval

0.01 to 86400 seconds, depending on purchased options

General Details
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Table 15. General Receiver Specifications

Output

Communication Ports

¢ High-speed RS232 serial port (rimmed in green)

e USB 2.0 up to 480 Mbps

USB device with mass storage and virtual serial port
functionality

USB host supporting mass storage devices under Micro
USB A/B connector

¢ Internal Cell Modem

Bluetooth

¢ Internal Bluetooth:
LongLink™
Class 2
BLE

Serial Port Specifications

RS232 Serial Port:

¢ Baud rate: 460800, 230400, 115200 (default), 57600,
38400, 19200, 9600, 4800, 2400, 1200, 600, 300

¢ Flow control: RTS/CTS

e Length: 7 or 8 (default)

e Stop bit: 1 (default), 2

¢ Parity: None (default), Odd, Even

Connectors

e UHF or FH915 Modem Antenna (BNC or reverse polarity TNC
depending on modem type)

e PWR

e RS232 Serial

e USB 2.0 Micro-A/B

¢ External GNSS Antenna

MINTER (LED Display)

¢ 9 external LEDs
¢ ON/OFF control input (power button)

NMEA

NMEA 0183 Output

Ver. 2.x, 3., and 4.x

Messages

GGA, GLL, GMP, GNS, GRS, GSA, GST, GSV, HDT, RMS, ROT,
VTG, UID, and ZDA

Output Interval

1Hz standard; 5, 10, 20, Hz optional

DGPS

Correction Format

RTCM SC104 Ver 2.x and 3.x

RTCM Message Type

1, 3,9, 31, 32, 34; user selectable

Process Interval

1Hz standard; 10, 20, 50, 100 Hz optional

Output Interval for RTCM
Correction Data

1Hz standard; 10, 20, Hz optional

Elevation Mask

0 to 90 degrees (independent of data logging)

Real-Time Kinematic Mode

Correction Format®

RTCM SC104 Version 2.x, RTCM 3.x, RTCM 3.X MSM3,
CMR/CMR+ (Trimble compatible), TPS proprietary

Supported RTK Network
Solutions

VRS, MAC, FKP

General Details
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Table 15. General Receiver Specifications

Ambiguity Initialization

On-The-Fly (OTF): L1, L1/L2, L1/L2/L5

Baseline Length

Up to 50km, depending on atmospheric and multipath
conditions

Initialize Time

from 1 second depending on the baseline length (D) and
multipath conditions

Output Interval for
CMR/RTCM

1Hz standard; 10Hz and 20 Hz optional

Elevation

0 to 90 degrees (independent of data logging)

Solution Mode

Delay (synchronization) mode
Extrapolation (not synchronized) mode

Process Interval

1Hz standard; 10, 20, Hz optional

Survey Modes

Base or Rover

Autonomous (standalone)

DGPS (w/ user base)

DGPS (w/ SBAS)

Static

Kinematic (continuous, stop and go)
RTK (delay, extrapolation)

Positional Accuracy?

Static/Fast Static

L1 only:
H: 3mm + 0.8ppm (x baseline length)
V: 5mm + 1.0ppm (x baseline length)
L1+L2:®
H: 3mm + 0.3ppm (x baseline length)
V: 5mm + 0.5ppm (x baseline length)

Kinematic, RTK,
Network RTK

L1+L2:
H: 5mm + 0.5ppm (x baseline length)
V: 10mm + 0.8ppm (x baseline length)

RTK, TILT Compensated®

RTK accuracy, and additionally:

(TTFF)

H: 1.3mm/°Tilt; Tilt < 10°
H: 1.8mmy/° Tilt, Tilt > 10°
Code Differential GNSS H: <0.4m
V: <0.6m
DGPS H: <1.0m
V: <1.5m
Autonomous Accuracy H: <1.5m
V: <2.0m
Cold Start <40 sec.
Warm Start <20 sec.
Reacquisition <1 sec.
RTK Time-to-First-Fix <20 sec.

a. Vanguard ASIC includes four additional dedicated channels for L-Band signal tracking.
b. Varies with terrain and operating conditions.

General Details
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c. CMR/CMR+ is a third-party proprietary format. Use of this format is not recommended and
performance cannot be guaranteed. Use of industry standard RTCM 3.x is always
recommended for optimal performance.

d. Subject to multipath anomalies, interference, atmospheric conditions, and atypical satellite
geometry. GNSS survey best practices must always be applied.

e. The stated accuracy and reliability requires nominal observing conditions and strict processing
methods. This includes use of dual frequency GPS measurements, precise (final) ephemerides
during post-processing, calm ionospheric conditions, unobstructed visibility above 10 degrees,
approved antenna calibration parameters, and an observation duration of 3 hours or more
(dependent on baseline length). Accuracy and reliability may be subject to multipath
anomalies and atypical satellite geometry. GNSS survey best practices must always be applied.

f. Subject to successful TILT calibration, and an operating environment free of magnetic
disturbances.

R2 Lite UHF Internal Modem Board Details (Optional)
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Table 16 lists the HiPer HR’s optional R2 Lite UHF modem specifications.

Table 16. R2 Lite UHF Internal Modem Board Specifications

Operating Frequency 406MHz — 470MHz for Rover and Base
Range
Channel Spacing 6.25 KHz / 12.5 KHz / 20KHz / 25KHz user-selectable
Signal Modulation e 4FSK
e GMSK
Communication Mode Time division duplex
Supported Protocol(s) TPS, PDL, Trimble, Satel 3AS

Transmitter Carrier Power | 10, 20, 50, 100, 200, 500 and 1000 mW, user selectable

Receiver Sensitivity GMSK: -115 dBm at 10~ BER and 12.5 KHz spacing
4FSK: -106 dBm at 10~ BER and 12.5 KHz spacing

Receiver Dynamic Range -110 to -10 dBm

Serial Data Rate 115200 bps

Radio Data Rate 25KHz: 9600 bps for GFSK and 19200 pbs for 4FSK
12.5KHz: 4800 bps for GMSK and 9600 pbs for 4FSK

Antenna Type Whip antenna

Antenna Connector BNC

Error Correction FEC on/off

R2 Lite UHF Internal Modem Board Details (Optional) P/N: 1010117-01




R2 Lite FH915 Internal Modem Board Details

Table 17 lists the HiPer HR’s optional R2 Lite FH915 modem specifications.

Table 17. R2 Lite FH915 Internal Modem Board Specifications

Frequency Range
Country/Region/Purpose
Dependent

e 902.2 MHz — 927.8 MHz (128 channels), USA
¢ 915.2 MHz — 927.8 MHz (63 channels), AUS
¢ 920.8 MHz — 927.8 MHz (36 channels), NZL

Signal Structuring

Frequency-hopping spread spectrum

Hopping Pattern

5 per band, user-selectable

Hopping Channels

128 Channels

Occupied Bandwidth

+ 100KHz

Frequency Modulation
Technique

FSK, 64 Kbps

Network Topology

Point-to-point, Point-to-multipoint

System Gain

135dB

Operation Mode

Transmitter, receiver, repeater

Protocol

FHI15, FH915+

Transmitter Carrier Power

250mW (24 dBm)/1 W (30 dBm), user selectable

Receiver Sensitivity

-105 dBm at 10™* BER

Receiver Dynamic Range 105 dB
Serial Interface RS232
Serial Data Rate 115200 bps

Effective Radio Link Rate

9600, 10200, 17000, 51000 bps, user selectable for FH915

3600, 4800, 6600, 19200 for FH915+

Error Correction

FEC (15.7), majority decoding

Antenna Type

1/2 wave articulating whip

Antenna Connector

Reverse polarity TNC

Antenna Gain

2.5 dBi

R2 Lite FH915 Internal Modem Board Details P/N: 1010117-01
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Wi-Fi Module Details L
Table 18 list the HiPer HR’s Wi-Fi module specifications. Sh
Table 18. Wi-Fi Module Specifications S..
Type IEEE 802.11b,g,n compliant g
Mode Access point, Client v
Power 20.0 dBm, 11 Mbps, CCK(b)

14.5 dBm, 54 Mbps, OFDM(g)
12.5 dBm, 65 Mbps, OFDM (n)

Bluetooth Module Details

Table 19 list the HiPer HR’'s Bluetooth module specifications.

Table 19. Bluetooth Module Specifications

Range up to 50 m (indoor); up to 1000 m (outdoor)
Type Class 1

Service Classes Miscellaneous

Supported Profiles SPP, LongLink™

Frequency Country Code North America and Europe

Connector Specifications

The HiPer HR has one antenna connector for radio transmission/reception, and four port connectors for power,
data communication, and the external GNSS antenna. Cellular, LongLink, Bluetooth, and Wi-Fi antennas are
internal.

Radio (Modem) RF Connector

The modem connector (Table 20) is a reverse TNC connector for 915+ radio, and a BNC connector for UHF radio.

Table 20. Modem Connector Specifications

Modem Type Signal Type Dir Details
915+ Reverse TNC | Modem I/O I/0 RF output from modem
antenna
UHF BNC Modem I/O I/0 RF output from modem
antenna

Wi-Fi Module Details P/N: 1010117-01 73




Power Connector

The power connector (Figure 47) is a sealed receptacle, 5 pin, ODU part number G80F1C-T05QF00-0000.
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Figure 47: Power Connector

Table 21 describes power connector specifications.

Table 21. Power Connector Specifications

Number Signal Name Dir Details

1 Power_INP P 9 to 28 volts DC input
2 Power_INP P 9 to 28 volts DC input
3 Power_GND P Ground, power return
4 Power_GND P Ground, power return
5 Aux_Power P 9 to 28 volts DC input

Connector Specifications P/N: 1010117-01




Serial C-RS232 Connector L
(]

The serial RS232 connector (Figure 48) is a sealed receptacle, 7 pin, ODU part number G80F1C-T07QC00-0000. Qh
=
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Figure 48: Serial RS232 Connector
Table 22 gives the RS232 cable connector specifications.

Table 22. RS232 Connector Specifications

Number Signal Name Dir Details
1 Not used

2 GND - Signal ground

3 CTS I Clear to send

4 RTS 0] Request to send

5 RXD I Receive data

6 TXD 0] Transmit data

7 PPS 0] 1PPS

Connector Specifications P/N: 1010117-01




Micro USB Connector

The Micro USB connector is a standard 5-pin micro USB A/B connector (Figure 49).
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Figure 49: USB Connector for GGD Options
Table 23 gives the Micro USB connector specifications.

Table 23. USB Specifications

Number | Signal Name Dir Details
1 USB_PWR P Bus power input

2 USB D- I/0 Data minus

3 USB D+ 1/0 Data plus

4 ID I USB ID

5 GND P Ground

Connector Specifications P/N: 1010117-01




Product Identification

The HiPer HR receiver, featuring Vanguard™ Technology, supports 452 channels, which are listed in Table 24 by
serial number range.

Table 24. Product Serial Numbers

Part Number Description Serial Number
1006276-03 HiPer HR (No UHF/FH915) 1405
1006276-01 HiPer HR R2 Lite UHF 1407
1006276-02 HiPer HR R2 Lite FH915 1406

Product Identification

P/N: 1010117-01
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Safety Warnings

General Warnings

To comply with RF exposure requirements, maintain at least 32cm between the user and the radio
modem.

TPS receivers are designed for survey and survey related uses (that is, surveying coordinates,
distances, angles and depths, and recording such measurements). This product should never be
used:

¢ Without the user thoroughly understanding this manual.

¢ After disabling safety systems or altering the product.

With unauthorized accessories.

¢ Without proper safeguards at the survey site.
¢ Contrary to applicable laws, rules, and regulations.

TPS receivers should never be used in dangerous environments. Use in rain or snow for a limited
period is permitted.

Battery Pack Warnings

Never attempt to open the casing of the removable batteries! Lithium-Ion batteries can be dangerous if
mishandled!

Do not incinerate or heat battery pack above 185 degrees Fahrenheit (85 degrees Celsius). Excessive
heat can cause serious damage and possible explosion.

Tampering with the batteries by end users or non-factory authorized technicians will void the battery’s
warranty.
® Do not attempt to open the battery pack or replace it.
Do not disassemble the battery pack.
Do not charge in conditions different than specified.
Do not use other than the specified battery charger.
Do not short circuit.
Do not crush or modify.

Dispose of batteries in accordance with your local regulations.
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Receiver Warnings

receiver’s warranty:
® Do not attempt to open the receiver and modify any of its internal components.

® Do not charge in conditions different than specified.
® Do not short circuit.

' Tampering with the receiver by the end users or non-factory authorized technicians will void the

Usage Warnings

otherwise treated without care, erroneous measurements may occur.

The surface of the unit may overheat under maximum operating temperature conditions. Use caution
when operating under this condition. No impact on functionality will occur if operating within the
temperature limit. See “Specifications” on page 66 for operating temperatures.

The owner should periodically test this product to ensure it provides accurate measurements.

Inform TPS immediately if this product does not function properly.

' If this product has been dropped, altered, transported or shipped without proper packaging, or

Receiver Warnings P/N: 1010117-01
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Regulatory

The following sections provide information on this product’s compliance with government regulations for use.
FCC Compliance

This equipment complies with FCC radiation exposure limits set forth for uncontrolled equipment and meets the
FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65. This equipment has very low levels of
RF energy that it deemed to comply without maximum permissive exposure evaluation (MPE). But it is desirable
that it should be installed and operated with at least 32cm and more between the radiator and person’s body
(excluding extremities: hands, wrists, feet and ankles).

This equipment has been tested and found to comply with the limits for a Class A digital device pursuant to part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

If this equipment does cause interference to radio or television equipment reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

¢ Reorient or relocate the receiving antenna.

* Move the equipment away from the receiver.

* Plug the equipment into an outlet on a circuit different from that to which the receiver is powered.

¢ Consult the dealer or an experienced radio/television technician for additional suggestions

have been tested shall be used. It is permissible to use different antenna manufacturer provided the
same antenna type and antenna gain (equal to or less than) is used.

Antenna Type: 1/4 wave antenna

Gain: 4.0 dBi max

@ To maintain modular approval of R2Lite FH915 modem in United States, only the antenna types that

Any changes or modifications to the equipment not expressly approved by the party responsible for
compliance could void your authority to operate such equipment.
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Industry Canada Compliance

This class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérigue de /a classe A est conforme a la norme NMB-003 du Canada.

A1ojen3ay

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the
following two conditions: (1) this device may not cause interference, and (2) this device must accept any
interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de
licence. L'exploitation est autorisée aux deux conditions suivantes : (1) I'appareil ne doit pas produire de
brouillage, et (2) I'utilisateur de I'appareil doit accepter tout brouilage radioélectrique subi, méme si le brouillage
est susceptible d’en compromettre le fonctionnement.

CAN ICES-3(A)/NMB-3(A)

with the antenna types listed below with the maximum permissible gain indicated. Antenna types not
included in this list, having a gain greater than the maximum gain indicated for that type, are strictly
prohibited for use with this device.

Antenna Type: 1/4 wave antenna

Gain: 4.0 dBi max

@ This radio Transmitter (IC:6050B-R2LITEFH915) has been approved by Industry Canada to operate

les types d'antenne énumérés ci-dessous avec le gain maximal autorisé est indiqué types d'antennes
non inclus dans cette liste, ayant un gain supérieur au gain maximum indiqué pour ce type, sont
strictement interdits pour une utilisation avec cet appareil.

Type d'antenne : antenne d'onde 1/4

Gain: 4.0 dBi max

@ Cet émetteur radio (IC : 6050B - R2LITEFH915) a été approuvé par Industrie Canada coopérer avec
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Community of Europe Compliance

The product described in this manual is in compliance with the R&TTE and EMC directives from the European
Community.

A1ojen3ay

European Community Declaration of Conformity

European Community Declaration of Conformity with Radio Equipment Directive 2014/53/EU
The following standards were applied:

e ETSIEN 301 489-1v1.9.2

e ETSIEN 301 489-3 vi.6.1

e ETSI EN 301 489-5v1.3.1

e ETSIEN 301 489-7 v1.3.1

e ETSIEN 300 328 v1.8.1

e EN 55022:2010/AC:2011

* EN 55024:2010

e ETSIEN 301 511v9.0.2

* EN62311:2008

e ETSIEN 301 489-17 v2.2.1

e ETSIEN 301 489-24 v1.5.1

e ETSI EN 301 908-2 v6.2.1

e ETSIEN 301 908-1 v6.2.1

e ETSI EN 300 400-2 vi.4.1

* EN 60950-1:2006;+A11:2009+A1:2010+A12:2011+A2:2013
The following CE mark is affixed to the device:

C€

This is a Class A product. In a domestic environment this product may cause radio interference in
which case the user may be required to take adequate measures.

Declaration of Conformity (R&TTE Directive 1999/5/EC)

esky [Czech] | (Topcon)timto prohlasuje, Ze tento (HiPer HR) je ve shod se zakladnimi
pozadavky a dalsimi pislusnymi ustanovenimi smrnice 1999/5/ES.

Dansk Undertegnede (7opcon) erklaerer herved, at fglgende udstyr (HiPer HR)

[Danish] overholder de vaesentlige krav og gvrige relevante krav i direktiv
1999/5/EF.

Deutsch Hiermit erklart (7opcon) dass sich das Gerat (HiPer HR)in

[German] Ubereinstimmung mit den grundlegenden Anforderungen und den
Ubrigen einschldagigen Bestimmungen der Richtlinie 1999/5/EG befindet.

Eesti Kaesolevaga kinnitab (7opcon) seadme (HiPer HR) vastavust direktiivi

[Estonian] 1999/5/EU pohinduetele ja nimetatud direktiivist tulenevatele teistele
asjakohastele satetele.

English Hereby, (Topcon) declares that this (HiPer HR) is in compliance with the
essential requirements and other relevant provisions of Directive
1999/5/EC.
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Espariol
[Spanish]

[Greek]

Frangais
[French]

Italiano
[Italian]

Latviski
[Latvian]

Lietuvi
[Lithuanian]

Nederlands
[Dutch]

Malti [Maltese]

Magyar
[Hungarian]

Polski [Polish]

Portugués
[Portugues]

Slovensko
[Slovenian]

Slovensy
[Slovak]

Suomi
[Finnish]

Svenska
[Swedish]

Por medio de la presente (7opcon) declara que el (HiPer HR) cumple con
los requisitos esenciales y cualesquiera otras disposiciones aplicables o
exigibles de la Directiva 1999/5/CE.

ME THN MAPOYZA (Topcon Positicning Systems,
Inc.) AHAQNEI OTI (HirerR) ZYMMOPOQNETAIL
MPOZTIZ OYZIQAEIZ ANAITHZEIZ KAI TIZ ACIMNEZ
ZXETIKEZ AIATAZEIZ THZ OAHITAZ 1999/5/EK.

Par la présente (7opcon) déclare que l'appareil (HiPer HR) est conforme
aux exigences essentielles et aux autres dispositions pertinentes de la
directive 1999/5/CE.

Con la presente (Topcon) dichiara che questo (HiPer HR) € conforme ai
requisiti essenziali ed alle altre disposizioni pertinenti stabilite dalla
direttiva 1999/5/CE.

Ar So (Topcon) deklar, ka (HiPer HR) atbilst Direktvas 1999/5/EK
btiskajm prasbm un citiem ar to saisttajiem noteikumiem.

Siuo (7opcon) deklaruoja, kad $is (HiPer HR) atitinka esminius
reikalavimus ir kitas 1999/5/EB Direktyvos nuostatas.

Hierbij verklaart (7opcon) dat het toestel (HiPer HR) in
overeenstemming is met de essentiéle eisen en de andere relevante
bepalingen van richtlijn 1999/5/EG.

Hawnhekk, (7opcon), jiddikjara li dan (HiPer HR) jikkonforma mal-tiijiet
essenzjali u ma provvedimenti orajn relevanti li hemm fid-Dirrettiva
1999/5/EC.

Alulirott, (7opcon) nyilatkozom, hogy a (HiPer HR) megfelel a vonatkozo

alapvetG kovetelményeknek és az 1999/5/EC iranyelv egyéb eldirasainak.

Niniejszym, (7opcon) , deklaruj, e (HiPer HR) spenia wymagania

zasadnicze oraz stosowne postanowienia zawarte Dyrektywie 1999/5/EC.

(Topcon) declara que este (HiPer HR) esta conforme com os requisitos
essenciais e outras disposicoes da Directiva 1999/5/CE.

(Topcon) izjavlja, da je ta (HiPer HR) v skladu z bistvenimi zahtevami in
ostalimi relevantnimi doloili direktive 1999/5/ES.

(Topcon) tymto vyhlasuje, ze (HiPer HR) spa zakladné poziadavky a
vSetky prislusné ustanovenia Smernice 1999/5/ES.

(Topcon) vakuuttaa taten etta (HiPer HR) tyyppinen laite on direktiivin
1999/5/EY oleellisten vaatimusten ja sitd koskevien direktiivin muiden
ehtojen mukainen.

Harmed intygar (7opcon) att denna (HiPer HR) stdr I Overensstammelse
med de vasentliga egenskapskrav och 6vriga relevanta bestammelser
som framgar av direktiv 1999/5/EG.

Declaration of Conformity (R&TTE Directive 1999/5/EC) P/N: 1010117-01
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WEEE Directive

Following information is for EU-member states only:

The use of the symbol below indicates that this product may not be treated as household waste. By ensuring
this product is disposed of correctly, to help prevent potential negative consequences for the environment and
human health, which could otherwise be caused by inappropriate waste handling of this product. For more
detailed information about the take-back and recycling of this product, please contact a supplier where you
purchased the product or consult.

A1ojen3ay

Bluetooth Transmission Statements/Compliance

This Bluetooth device is compliant to the following profiles of the core spec version 2.1/2.1+EDR:

* Baseband

* HCI

* Link Manager

* Radio
The radio has been tested using the maximum antenna gain of 2.3 dBi and the Bluetooth qualification is valid
for any antenna with the same or less gain.

Korean KC-RF Compliance

RI5EE (Product Id Code): MSIP-RMM-T8S-6276

Applicant: Topcon Positioning Systems, Inc.

Type of equipment: GPS surveying device with Bluetooth, Wi-Fi, UHF radio, and Cellular modem.
Model Name: HiPer HR

Year of manufacture: 2016

Manufacturer and country of origin: Topcon Positioning Systems, Inc. U.S.A.

Applicant Code: T8S

Korean KC-EMC Class A Statement

o] 7|7|= HF& (Ag) TAL Ht7|7|=2M HOjA} == AFEALE O] S FOISHA|7] Hi2HH ,
78 elel XM A8otE AE FH2 = gL

This optional integrated cellular modem (PXS8) reference application complies with the requirements of the
Korean Communications Commission (KCC). The certificate granted in accordance with KCC has the identifier:
MSIP-CRM-T8S-PXS8.
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Japan Radio/Telecommunications Law Compliance

It is verified that Bluetooth Longlink, BLE, Wi-Fi, and UHF modules have been certfified under clause 2, Article
58-2 of the radio Waves Act.

¢ Bluetooth LongLink — KCC-CRM-BGT-WT41-E

¢ BLE — MSIP-CRM-T8S-PAN1711

* Wi-Fi — MSIP-CRM-T8S-TiWi5

* R2Lite UHF — MSIP-CRM-T8S-R2LITEUHF

Japan Bluetooth and Wi-Fi Module Compliance

A1ojen3ay

The integrated Bluetooth LongLink, BLE, and Wi-Fi module reference application described on page 73 complies
in accordance with the provisions of Article 38-24 paragraph 1 of Japan Radio Law. The certificate granted in
accordance with Japan Radio Law has the identifier R 209-J00047 (Bluetooth LongLink), R 211-160821 (BLE),
and R 211-160820 (Wi-Fi).

Cellular Module Compliance

The optional integrated cellular modem (PXS8) reference application complies with the requirements of the
Japanese Telecommunications Business Law and Ordinance Concerning Conformity Certification of Specified
Radio as well as with the requirements of the Japanese “Radio Law” and “Ordinance Concerning Technical
Conditions Compliance Approval and Certification Type for terminal Equipment.”

The certificate granted in accordance with the Telecommunications Business Law has the identifier R 211-
160813.

The certificate granted in accordance with the “"Radio Law” has the identifier T AD160012211.
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Warranty

Topcon laser and electronic positioning equipment are guaranteed against defective material and workmanship
under normal use and application consistent with this Manual. The equipment is guaranteed for the period
indicated, on the warranty card accompanying the product, starting from the date that the product is sold to the
original purchaser by Topcon’s Authorized Dealers.!

During the warranty period, Topcon will, at its option, repair or replace this product at no additional charge. Repair
parts and replacement products will be furnished on an exchange basis and will be either reconditioned or new.
This limited warranty does not include service to repair damage to the product resulting from an accident, disaster,
misuses, abuse or modification of the product.

Warranty service may be obtained from an authorized Topcon warranty service dealer. If this product is delivered
by mail, purchaser agrees to insure the product or assume the risk of loss or damage in transit, to prepay shipping
charges to the warranty service location and to use the original shipping container or equivalent. A letter should
accompany the package furnishing a description of the problem and/or defect.

The purchaser’s sole remedy shall be replacement as provided above. In no event shall Topcon be liable for any
damages or other claim including any claim for lost profits, lost savings or other incidental or consequential
damages arising out of the use of, or inability to use, the product.

1. The warranty against defects in a Topcon battery, charger, or cable is 90 days.
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Glossary

Glossary

BDS — BeiDou Navigation Satellite System maintained and operated by China. See also, BeiDou.

Base Station — A GNSS receiver set up over a known point, which is used to derive correction information for
nearby Rover (mobile) GNSS receivers.

BeiDou — Navigation Satellite System maintained and operated by China. See also, BDS.

Bluetooth® — Often used in place of cables, Bluetooth is open wireless technology for exchanging data over
short distances from fixed and mobile devices.

G

GALILEO - The satellite system currently being maintained and operated by the European Union (EU) and
European Space Agency (ESA).

GGD - GPS + GLONASS Dual Frequency signal tracking.

GLONASS — The GLObal NAvigation Satellite System maintained and operated by the Russian Federation.
GNSS — Global Navigation Satellite Systems, such as GPS and GLONASS.

GPS — The Global Positioning System maintained and operated by the United States Department of Defense.
L

L1 — The primary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

L2 — The secondary L-band carrier used by GPS and GLONASS satellites to transmit satellite data.

Light-Emitting Diode (LED) — Used as indicator lights on the receiver to display the status of the receiver’s
components and control receiver operations.

MAGNET Field™ — Data controller software that is part of the MAGNET software system.

MAGNET Office™ — Post-processing and CAD solution software for surveying and grade application. It is part of
the MAGNET software system.

MINTER - The receiver’s Minimum INTERface used to display and control data input and output.

Network RTK — Collects satellite observations from the reference stations within the network and sends RTK
corrections to the Rover.

0

Option Authorization File (OAF) — This enables the specific features that a customer purchases.

P

Phase Center of Antenna — The point from which the electromagnetic radiation spreads spherically outward,
with the phase of the signal being equal at any point on the sphere.

Pocket-3D — Field controller software by Topcon that supports both GNSS and TS.
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Real-Time Kinematic (RTK) — A precise method of real-time surveying. RTK enables you to check the
measurement quality without having to process the data.

Root Mean Square (RMS) — Statistical measure of the magnitude of a varying quantity.
Rover — A mobile GNSS receiver and data collector used for determining location in the field.

S

Satellite-Based Augmentation Systems (SBAS) — Complements existing global navigation systems.
SBAS transmits differential corrections and messages for navigation satellites that are within sight of a
network or reference stations in a wide area, such as a continent.

Static Survey — Typically uses a network or multiple baseline approach for positioning. This method
provides the highest accuracy and requires the longest observation times.

T

Topcon Receiver Utility (TRU) — Hardware configuration software for receivers and peripheral devices.
TRU is included on the GPS+ Software CD that accompanied your receiver.

u

Universal Serial Bus (USB) — A connection standard used by devices, such as a receiver, controller,
computer, etc.
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